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Version 3.1

• 本マニュアルは、日本語・英語での二か国語バイリンガル表記となっております。日本語の下もしくは、横に同じ内容が英
語でも表記されております。

• 目次及び参照先へのハイパーリンクが貼られております。ご確認頂く際の参考にして下さい。

• This manual is written in a bilingual form (Japanese and English). The explanation in English is under or 
next to Japanese characters.

• Hyperlinks to an index or a reference page are on some slides.
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改定履歴
Revision History

版数
(Version)

年月日
(Date)

内容
(Description)

1.00 2014/5/22 [Android]  [iOS]  [Windows]
初版/ First Edition

1.01 2014/5/29

[Android(P42)]  [iOS(P45)]  [Windows(P40)]
1. パスワードの登録可能文字を修正/Modified characters that can 

be registered for password.
[Windows(P10)]
2. vAppダウンロード方法を修正/Modified the method of 

downloading vApp.

[Windows]
1.02 2014/8/15

[Windows(P11)]
1. Microsoft .NET Framework のバージョン修正/Modified the 

version of Microsoft .NET Framework .
[Windows(P14)]
2. インストールエラー時の詳細追記/Added the detail about the 

error at installing.

[Android]  [iOS]
1.02

[Windows]
1.03

2014/11/27

[Android(P6)]  [iOS(P6)] [Windows(P6,15~29)]
1. vApp(Windows)のアイコン画像を差し替え/Replaced the image 

of vApp(Windows) icon.
[Android(P12)]  [iOS(P12)] [Windows(P15)]
2. IPアドレスは固定出来ない旨を追加/Added the description that 

IP address cannot be fixed.
[iOS(P16)]
3. iOS8以降の端末に表示されるボタンについて追記/Added the 

button that appears on the terminal of iOS8 or later.
[Windows(P14)]
4. エラー1722について追記/Added the information about error 

1722.
[Android(P40,42)] [iOS(P43,45)]  [Windows(P38,40)]
5. メールを最新化/Updated Email.
[Android(P41)] [iOS(P44)]  [Windows(P39)]
6. 古いURLへアクセスした場合を追加/Added the case when 

accessing to old URL.
[Android(P43)] [iOS(P46)]  [Windows(P41)]
7. PWの文字制限について修正/Corrected restrictions on characters 

of PW.
[Android(P44)] [iOS(P47)]  [Windows(P42)]
8. PW変更手順について修正。メール最新化/Corrected how to 

change password. Updated E-mail.
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改定履歴
Revision History

版数
(Version)

年月日
(Date)

内容
(Description)

2.00 2015/5/20

[Android(P38~40)] [iOS(P38~39)]  [Windows(P31~36)]
1. エラーコード修正/ Updating error code. 
[Android(P41,43,45)] [iOS(P43,45,47)]  [Windows(P37,39,41)]
2. メール件名を最新化/ Updating E-mail.
[Windows(P10)]
3. サポートサイトの操作説明を削除/ Deleting the explanation of 

Business Portal.
[Windows(P11~12)]
4. ウィザードインストール手順を簡素化/ To simplify a Wizard 

installation procedure.
[English version]
5. 英語版のvAppマニュアルを統合/Merged the document(English 

version) mentioned above.
[English version]
6. 英語版のvGWのセグメントを修正/Updating vGW’s 

segment(English version).

2.1 2015/6/10

[Japanese version] [English version]
1. 日本語版と英語版のvAppマニュアルを統合/Merged the 

document(English and Japanese  version) mentioned above.
2. 対応OSのマイナーバージョンを削除/ Deleted minor version of 

supporting system

2.2 2015/8/6

1. 奥付を修正/ Modified colophons
2. 英訳漏れを修正 / Added information
3. プライバシーポリシー、ソフトウェア使用許諾契約書を追加

/ Added privacy policy and software license agreement
4. vApp(Windows)ダウンロードURLを変更/ Modified the URL of 

vApp(Windows)

2.3 2015/10/6

1. vAppのPW変更画面を変更/Updating screen of change password 
for vApp

2. iOS9,Win10対応を追加 / Added iOS9 and Windows10 version of 
supporting system

2.4 2015/11/20

1. 対応OSにMacを追加 / Add supporting system of vApp for Mac
2. Android5対応を追加 / Added Android5 version of supporting 

system
3. 機体認証機能を追記 / Add function of the device authentication 

option.
4. Microsoft .NET Framework のバージョン修正/Modified the 

version of Microsoft .NET Framework .
5. Windows更新の注意文を追記 / Add caution of update of 

Windows's vApp

2.5 2016/1/8 1. メール文章を修正/ Modified the mail of notification
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改定履歴
Revision History

版数
(Version)

年月日
(Date)

内容
(Description)

2.6 2016/6/29
1. コピーライトのアップデート/ Updating copyright.
2. 対応OSのWin8を削除 / Deleted supporting system of vApp for 

Windows 8.

2.7 2016/9/16

1. iOS/MacOSのプロファイル再インストール手順の修正 / 
Modified the reinstallation operation of the configuration profile of 
iOS and MacOS.

2. Android6、Android7対応を追加 / Added Android6 and Android7 
version of supporting system

3. 接続案内メール内のWindowsリンク修正 / (Modification is 
Japanese only.)

2.8 2016/12/13
1. iOS10、Mac OS 10.11, 10.12対応を追加 / Added iOS10 and  Mac 

OS 10.11, 10.12 version of supporting system

2.9 2017/9/25
1. iOS 11、 MacOS 10.13 、Android 8対応を追加 / Added iOS11 and  

Mac OS 10.13 and Android 8  version of supporting system

3.0 2019/3/14
1. iOS 12、 MacOS 10.14 、Android 9対応を追加 / Added iOS12 and  

Mac OS 10.14 and Android 9  version of supporting system

3.1 2019/10/11
1. iOS 13、 MacOS 10.15 、Android 10対応を追加 / Added iOS13 

and  Mac OS 10.15 and Android 10  version of supporting system
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2. Android

(日本語)
2-1. インストール
2-2. 設定

2-2-1. ユーザID登録方法
2-2-2. ユーザID設定変更(削除)
2-2-3. 機体認証機能の設定

2-3. VPN接続/切断
2-3-1. 接続
2-3-2. 切断
2-3-3. 終了

2-4. その他サポート
2-5. アンインストール

1. 概要 / Outline
(日本語)
1-1. はじめに

1-1-1. 本書の記載範囲について
1-1-2. Arcstar Universal One Virtual vApp とは
1-1-3. 用語説明

1-2. システム利用環境
1-2-1. 動作環境
1-2-2. その他
1-2-3. 提供国

* Screens in this document are created by using Nexus5.

目次/ Index

* 本書の画面はNexus5等を用いて作成しております。

(English)
1-1. Introduction

1-1-1. Scope of this document
1-1-2. What is Arcstar Universal One Virtual vApp?
1-1-3. Terminology

1-2. System Requirements
1-2-1. Operating environment
1-2-2. Others
1-2-3. Coverage Area

(English)
2-1. Installation
2-2. Setting

2-2-1. How to Register the User ID
2-2-2. Modification of Settings of User ID (Deletion)
2-2-3. Settings of Device Authentication

2-3. VPN Connection/ Disconnection
2-3-1. Connection
2-3-2. Disconnection
2-3-3. Exit

2-4. Other supports
2-5. Uninstallation
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目次/ Index

3. iOS * Screens in this document are created by using iOS7.
* 本書の画面はiOS7を用いて作成しております。

(日本語)
3-1. インストール
3-2. 設定

3-2-1. ユーザID登録方法
3-2-2. ユーザID設定変更(削除)
3-2-3. 機体認証機能の設定

3-3. VPN接続/切断
3-3-1. 接続
3-3-2. 切断
3-3-3. 終了

3-4. その他サポート
3-5. アンインストール

(English)
3-1. Installation
3-2. Setting

3-2-1. How to Register the User ID
3-2-2. Modification of Settings of User ID (Deletion)
3-2-3. Settings of Device Authentication

3-3. VPN Connection/ Disconnection
3-3-1. Connection
3-3-2. Disconnection
3-3-3. Exit

3-4. Other supports
3-5. Uninstallation

4. Windows

(日本語)
4-1. インストール
4-2. 設定

4-2-1. ユーザID登録方法
4-2-2. ユーザID設定変更(削除)
4-2-3. 機体認証機能の設定

4-3. VPN接続/切断
4-3-1. 接続
4-3-2. 切断
4-3-3. 終了

4-4. その他サポート
4-5. アンインストール
4-6. その他

4-6-1. アップデート

* Screens in this document are prepared by using Windows7.
* 本書の画面はWindows7を用いて作成しております。

(English)
4-1. Installation
4-2. Setting

4-2-1. How to Register the User ID
4-2-2. Modification of Settings of User ID (Deletion)
4-2-3. Settings of Device Authentication

4-3. VPN Connection/ Disconnection
4-3-1. Connection
4-3-2. Disconnection
4-3-3. Exit

4-4. Other supports
4-5. Uninstallation
4-6. Others

4-6-1. Update
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6. パスワード変更 /  Changing the password

(日本語)
6-1. パスワード変更

(English)
6-1. Changing the password

7. エラーコード /  Error code

(日本語)
7-1. エラーコード

(English)
7-1. Error code

5. Mac

(日本語)
5-1. インストール
5-2. 設定

5-2-1. ユーザID登録方法
5-2-2. ユーザID設定変更(削除)
5-2-3. 機体認証機能の設定

5-3. VPN接続/切断
5-3-1. 接続
5-3-2. 切断
5-3-3. 終了

5-4. その他サポート
5-5. アンインストール

(English)
5-1. Installation
5-2. Setting

5-2-1. How to Register the User ID
5-2-2. Modification of Settings of User ID (Deletion)
5-2-3. Settings of Device Authentication

5-3. VPN Connection/ Disconnection
5-3-1. Connection
5-3-2. Disconnection
5-3-3. Exit

5-4. Other supports
5-5. Uninstallation

* Screens in this document are created by using OS X10.10.
* 本書の画面はOS X10.10を用いて作成しております。
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Chapter 1: Outline
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お
客
さ
ま

コンサルティング
（NTT Com営業担当）

お申込み

ご利用開始

開通案内発送

STEP1

STEP2

ビ
ジ
ネ
ス
ポ
ー
タ
ル(Virtual

ポ
ー
タ
ル)

vAppのインストール

STEP4 vClient 、および各種の登録 *1

ＩＤ、パスワードの配信STEP5

vAdapter発送STEP3

Ｎ
Ｔ
Ｔ
コ
ミ
ュ
ニ
ケ
ー
シ
ョ
ン
ズ

ア
プ
リ
ス
ト
ア

/N
TTCom

H
P

STEP6

vApp設定STEP7

vAdapter設置STEP8

・Arcstar Universal One Virtualのご利用開始までの流れ イメージ図

本書記載範囲

下図は、Arcstar Universal One Virtualのご利用開始までの全体の流れです。
本書は、STEP6とSTEP7が記載範囲となります。
他STEPや全体の確認を行う場合は、『IT管理者向けご利用ガイド』をご参照ください。

１－１．はじめに

１－１－１．本書の記載範囲について

第1章 : 概要
Chapter 1: Outline

*1…機体認証機能をご利用される場合、ポータルに登録する
vClient情報に「機体認証番号」が必要となります。

9
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サービスイメージ

①仮想ネットワークへの接続が許可されたユーザは本クライアントをインストールすることで、
お客様拠点のVPNやNTTComクラウドサービス等のご利用サービスへ接続することができます。

②仮想ネットワークへの接続を許可されていないユーザは本クライアントをインストールしても、
お客様拠点のVPNやご利用サービスへ接続することはできません。

Arcstar
Universal One 等

Internet

①許可された
クライアント

お客様拠点

NTT Com
クラウドサービス/
アプリケーション

②許可されていない
クライアント

インターネット上は
暗号化

PC端末利用 スマートデバイス利用

１－１－２． Arcstar Universal One Virtual vApp とは
Arcstar Universal One Virtual vApp (以下、本クライアント)は「Arcstar Universal One Virtual 」の
クライアント機能をソフトウェアで提供するシステムです。
お客様ネットワークへの接続を許可されたユーザは本クライアントを端末にインストールすることにより、
インターネットを経由して仮想ネットワークへ参加することが可能になります。

第1章 : 概要
Chapter 1: Outline

10
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区分 用語 説明

契
約
関
連

仮想ネットワーク
Arcstar Universal One Virtualサービスによって構成され
るお客さまのVPN（仮想専用網）のネットワーク全体を指
します。

端
末
関
連

vAdapter お客さま宅内に設置し、仮想ネットワークへ接続するため
の起点となる装置を指します。

vApp
お客さまのパソコンやスマートデバイスにインストールし、
仮想ネットワークへ接続するための起点となるアプリケー
ションを指します。

vCore 弊社内に設置し、仮想ネットワークの終点となる装置を指
します。

ビジネスポータル
（Virtual編）

本ポータルを用いて、Arcstar Universal One Virtualサー
ビスの設定追加や変更、削除を実施します。

ビジネスポータル
NTTコミュニケーションズ ビジネスポータルを指します。
（本ポータルより、Arcstar Universal One Virtualの設定
変更を実施するサイトへ推移します。）

そ
の
他

管理者 ビジネスポータルを利用するシステム管理者等を指します。
管理者にてID追加や変更、削除を実施します。

１－１－３． 用語説明

ブイアダプター

ブイアップ

ブイコア

アークスター ユニバーサル ワン バーチャル

第1章 : 概要
Chapter 1: Outline
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■Android
・対応バージョン：4 - 10

（2.3のバージョンでもインストールはできますが、動作保証はできません。）

■iOS
・対応バージョン：6 – 13

※iPad OSでの動作は未確認です。

■Windows
・Windows 7 / 8.1 / 10

■Mac
・OS X v10.9 – 10.15

１－２．システム利用環境

１－２－１．動作環境 ※2019年10月現在

・インターネットへ接続できる環境が必要

１－２－２．その他

１－２－３．提供国
・提供国以外には本アプリの持ち出しはできません。

提供国は、下記ホームページを参照して下さい。
http://www.ntt.com/a_virtual/data/plan_fee.html

第1章 : 概要
Chapter 1: Outline

12
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1-1. Introduction
1-1-1. Scope of this document

The flow chart of Arcstar Universal One Virtual until activation is as follows.
The scope of this document is STEP 6 and 7.
Therefore, please refer to “Usage Guide book of Arcstar Universal One Virtual”, for other STEP or 
general specifications.

The flow of Arcstar Universal One Virtual until activation 

Start of use

Custom
er

Consulting
(NTT Com Sales）

Order Entry

Service Start Notification

STEP1

STEP2 N
TT Com

m
unication’s Business Portal (Virtual portal)Install vApp

STEP4 Register vClient and other information *1

Notice ID and Pass wordSTEP5

Send vAdapterSTEP3

N
TT Com

m
unications

Application store
NTTCom HP

STEP6

Set up vApp settingSTEP7

Put in vAdapter.STEP8

Scope of this document

第1章 : 概要
Chapter 1: Outline

*1…When using function of Device Authentication, “Device-ID" is 
necessary information of the vClient as registered on the portal.

13
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1-1-2.  What is Arcstar Universal One Virtual vApp?

Arcstar Universal One Virtual vApp, which is called “this client application” in the following, provides 
the function of Arcstar Universal One Virtual by software.
A user who is allowed to connect the customer network is able to join a virtualized network via 
Internet by installing this client application on a PC, smartphone or similar device.

1) A user who is allowed to connect the customer network can connect to the service in use 
including VPN at customer site or NTTCom Cloud service by installing this client application on a PC, 
smartphone or similar device.

2) A user who is not allowed to connect the customer network cannot connect to the service in use 
including VPN at customer site even if he/she installs this client application on a PC, smartphone or 
similar device.

Image/ diagram

Arcstar Universal One, etc.

Internet

(1) Allowed client

Customer's 
base

NTT Com's Cloud 
Service/

Application

(2) Non-allowed client

Encrypted

PC user Smart device user

第1章 : 概要
Chapter 1: Outline
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1-1-3. Terminology

Terminology Description

Contract Virtual Network VPN (Virtual dedicated line) which is created by Arcstar Universal 
One Virtual.

Devices

vAdapter Device which is installed in the client home used for connecting to 
the Virtual Network.

vApp Applications and Software which are installed in PCs, smart phones, 
and similar devices and used for connecting to the VPN.

vCore Device which is the terminal of virtual network inside NTT Com.

Business portal
(Virtual version)

Portal which modify, add or delete any service of Arcstar Universal 
One Virtual.

Business portal
This is NTT Communications’ Business Portal.
(This portal is used to connect to the site where settings of Arcstar 
Universal One Virtual Portal can be changed.)

Others Administrator
System administrator who use the Business Portal.
Administrator can add, modify, or delete Arcstar Universal One 
Virtual ID.

第1章 : 概要
Chapter 1: Outline
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1-2. System Requirements
1-2-1. Operating environment *As of Sep, 2019

■Android
- Supported versions: 4 - 10

(vApp can be installed with Android version 2.3; however operation is not guaranteed.)

■iOS
- Supported versions: 6 - 13

■Windows
- Windows 7 / 8.1 / 10

■Mac
- OS X v10.9 - v10.15

1-2-2. Others
Environment where Internet connection is available is required.

1-2-3. Coverage Area
・Do not bring out vApp from coverage area.  Refer to the following URL about coverage area.

http://www.ntt.com/a_virtual_e/

第1章 : 概要
Chapter 1: Outline
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第2章 : Android

Chapter 2: Android
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①Androidのホーム画面から
Playストアのアイコンをタップして下さい。

②「 」をタップします。

③検索バーに「vApp」もしくは
「NTT communications」と入力し、検索して下さい。

④「vApp」アプリをタップして下さい。

１

vApp        

３

４

２

＜補足＞
Webブラウザに以下のURLを直接入力した場合も、
Playストア上のvAppダウンロード画面へ遷移できます。
URL→https://play.google.com/store/apps/details?i
d=com.ntt.vapp

２－１．インストール

第2章 : Android
Chapter 2: Android

18
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⑤「インストール」をタップして下さい。

⑥「同意する」をタップして下さい。

⑦「開く」をタップして下さい。
アプリが開きます。
以上でインストールは完了です。

５

vApp   

vApp   

７

vAppに必要な権限

６

＜注意＞
アプリ名が類似している商品にご注意ください。
必ず、NTTコミュニケーションズ公式のものを
インストール願います。

第2章 : Android
Chapter 2: Android
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通信状態 ※割当てられたIPアドレスは固定できません。

接続するユーザ名

VPNの接続/切断ボタン

タスクバー
・ホーム・・・ホーム画面を表示します。

・設定・・・・アカウントの追加や編集・削除、
オプションの設定を行う画面を
表示します。

・サポート・・サポートサイトへの案内や
保守ツールを実行できる画面を
表示します。

Youtube等で紹介している受信メールからの
自動設定は今後提供予定です。

２－２．設定

ホーム画面の構成については下記の通りです。

第2章 : Android
Chapter 2: Android

20

＜補足＞
vAppのバージョンがv3.1.0
以降の場合、
ホーム画面のデザインが
左記となります。
※機能の違いはございません。
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①Androidのホーム画面からvAppのアイコンを
タップして下さい。

②vAppのホーム画面が表示されます。

③設定タブをタップします。

１

３

２－２－１．ユーザID登録方法

第2章 : Android
Chapter 2: Android

21
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④「編集」をタップして下さい。

⑤「ID追加」をタップして下さい。

⑥任意の名前を入力して下さい。

⑦接続案内メール記載のユーザIDを入力して下さい。
※ユーザIDが分からない場合、

システム管理者へ確認してください。

４

６

５

７

第2章 : Android
Chapter 2: Android

22
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⑧必要に応じてデフォルト接続をタップし、チェックを付けます。
＊ID追加時は、⑧の操作以外に以下２つの方法があります。

…A．⑨の操作後、ユーザIDを長押しし、
「デフォルト」をタップします。

…B．設定タブ画面で、ユーザIDをプルダウンから選択し
ます。

⑨「OK」をタップして下さい。

８

９

A

B

第2章 : Android
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⑩デフォルト接続に設定したユーザIDに「 」が付きます。

⑪ をタップして下さい。(端末<戻る>ボタン)

⑫必要に応じてオプション設定を変更して下さい。
・端末認証の有効化 (オン/オフ)

…機体認証機能の利用有無を選択します。
(詳細は、2-2-3参照)

・アプリ起動時に自動接続 (オン/オフ)
…アプリを起動すると、デフォルト接続に設定した

ユーザIDが選択された状態で、パスワード入力画面が
表示されます。(詳細は、2-3-1④参照)

・ログの保存 (オン/オフ)
…AppLogを取得します。(詳細は、2-4-(5)参照)

⑬設定が完了したらホームタブをタップして下さい。

13

12

11

10

第2章 : Android
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＜補足＞
vAppのバージョンが
v3.1.0以降の場合、
デフォルトのデザインが
左記となります。
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①設定タブをタップして下さい。

②ユーザIDを削除したい場合は「編集」をタップして下さい。

２

１

２－２－２．ユーザID設定変更（削除）

第2章 : Android
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③削除したいユーザIDを２秒程長押しして下さい。

④「削除」をタップして下さい。

⑤「IDを削除します。よろしいですか？」と表示されますので
「OK」をタップして下さい。

５

４

３

第2章 : Android
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＜補足＞
vAppのバージョンがv3.1.0以降の場合、
「 」マークをタップし、メニュー表示してください。
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①設定タブをタップして下さい。

②「端末認証の有効化」をオンにして下さい。

２

１

２－２－3．機体認証機能の設定

第2章 : Android
Chapter 2: Android

※機体認証機能を利用しない場合、
2－3. VPN接続／切断へ進みます。
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③確認メッセージが表示されます。
「OK」をクリックして下さい。

④サポートタブをタップして下さい。

⑤「端末情報の表示」をタップして下さい。

5

第2章 : Android
Chapter 2: Android

３
＜注意＞
機体認証オプションを利用しない場合は、オプションを無
効にして下さい。

機体認証オプションが「オン」の場合、vAppに登録された
すべてのユーザIDに適用されます。

４
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⑥取得した端末識別ID(半角英数16字)は、お客様自身でシス
テム管理者へ連絡して下さい。

⑦端末識別IDをメール送信する場合は、「OK」をタップします。

第2章 : Android
Chapter 2: Android

7

6

＜補足＞
メーラーが立ち上がり、メールの本文に端末識別IDが記
載されたメールが作成されます。
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①ホーム画面で「ID：」の横（下線）をタップして
下さい。

②ユーザIDを選択してタップして下さい。
（例）ID：コム太郎

③ホーム画面で「接続」ボタンをタップして下さい。

３

１

２

２－３．VPN接続／切断
２－３－１．接続

第2章 : Android
Chapter 2: Android

30



(C) NTT Communications All Rights Reserved

Go to Index

④パスワードを入力します。
※パスワードが分からない場合、

システム管理者へ確認してください。

⑤「OK」をタップして下さい。

⑥注意画面が出ますので「このアプリケーションを信頼できる
ものとみなします。」にチェックを付けて下さい。
＊初めての時に注意画面が出ます。

⑦「OK」をタップして下さい。

４

５

６

７

＜注意＞
パスワードが違う場合
以下のようなエラーが表示されます。

第2章 : Android
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⑧接続に成功すると、 「 」が付きます。

⑨「Status」が「接続」に切り替わります。

９

８

第2章 : Android
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①vAppを立ち上げて、「切断」ボタンをタップして下さい。

１

２－３－２．切断

第2章 : Android
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① をタップして下さい。(端末<戻る>ボタン)

② をタップして下さい。(端末<ホーム>ボタン)

③ をタップして下さい。
(端末<最近利用したアプリ>ボタン)

＊端末によって、アイコンのマークが異なる場合があります。
ご使用の端末に従って操作を行ってください。

④起動中のvAppを左右どちらかにスワイプ（スライド）
して下さい。

＊端末によって、アプリ終了の操作が異なる場合があります。
ご使用の端末に従って操作を行ってください。

２１ ３

４

２－３－３．終了

第2章 : Android
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①ホーム画面のサポートタブをタップして下さい。

＊次ページにサポート画面の各メニューについて
説明があります。

１

２－４．その他サポート

第2章 : Android
Chapter 2: Android
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(1)サポートサイト
… Arcstar Universal One Virtual vAppのご利用方法などの

サポート情報を掲載したサイトへジャンプします。

(2)通信状態の取得
…通信が不安定や接続できない場合などにデバイスのネット

ワーク情報を取得・保存します。

(3)通信テスト
…ご利用のネットワークの通信状態を確認することができ
ます。
（Ping/Traceroute/Nslookup)

(4)端末情報の表示
…詳細は、2-2-3参照。

(5)ログの送信
…(2) (3)で保存した情報をメールで送信することができます。

(6)ソフトウェア使用許諾契約書
…ソフトウェアの使用許諾契約書を表示します。

(7)プライバシーポリシー
…プライバシーポリシーを表示します。

(8)このアプリについて
…ご利用中のArcstar Universal One Virtual vAppのバージョ

ンを確認することができます。

第2章 : Android
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(1)サポートサイト

①お客さまサポート画面が表示されます。

第2章 : Android
Chapter 2: Android
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①通信状態の取得画面が表示されます。
「OK」をタップして下さい。

１

(2)通信状態の取得

第2章 : Android
Chapter 2: Android
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①Pingの下線をタップして下さい。
プルダウンされます。

②プルダウンされた３種類の「Ping」「Traceroute」
「Nslookup」の中から該当するものを選択して
タップして下さい。
＊次ページで操作方法の流れを説明しています。

１

２

(3)通信テスト

第2章 : Android
Chapter 2: Android

＜注意＞
ご利用の端末によっては、「Ping」「Traceroute」
が表示されない場合があります。
その場合、「Ping」「Traceroute」はご利用になれ
ません。
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１

２

３

①Pingの下線をタップし、プルダウンから該当するものを
選択して下さい。

② IPアドレス／ホスト名を入力して下さい。
（例）www.ocn.jp

③「実行」をタップして下さい。

④ログが表示されます。しばらくお待ちください。

⑤「ログに保存」をタップして下さい。

⑥「ログを保存しました」と表示されます。
「OK」をタップして下さい。

４

６５

●操作方法●

第2章 : Android
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(4)サポート情報の送信画面に、
(2) 、(3)で取得したログファイルが表示されます。

①ログファイルの中から該当するものを選択して
タップをするとチェックが付きます。
＊複数選択出来ます。

＊表示順は、ファイル名昇順です。

＊ログの詳細
【 NWLog 】

取 得 条 件 ：(2)通信状態の取得
最大保持数 ：5個
ファイル名 ：年月日_時分秒_NWLog_android

↓
2014/4/1の12:34 56秒の場合

(例) 140401_123456_NWLog_android
【 TestLog 】

取 得 条 件 ：(3)通信テスト
最大保持数 ：5個
ファイル名 ：年月日_時分秒_TestLog_android

↓
2014/4/1の12:34 56秒の場合

(例) 140401_123456_ TestLog_android
【 AppLog 】

取 得 条 件 ：通信時
＊ログの保存が「オン」の場合のみ

最大保持数 ：3個 (3日分)
ファイル名 ：年月日_AppLog_android

↓
2014/4/1の場合

(例) 140401_AppLog_android

②「OK」をタップして下さい。

１

２

(5)サポート情報の送信

第2章 : Android
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③メーラーが立ち上がり、メールが作成されます。
メールの本文には、選択したログがすべて表示されます。

④「To」「件名」をタップし、それぞれ入力して下さい。

⑤「 」をタップして送信して下さい。
＊端末によって、操作が異なります。

ご使用のメーラーに従って操作を行ってください。

●●●●@ntt.com
４

５

３

第2章 : Android
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①アプリのバージョンが表示されます。
「OK」をタップして下さい。

１

(8)このアプリについて

第2章 : Android
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①端末の設定画面を開きます。

②「アプリ」をタップして下さい。

③「vApp」をタップして下さい。

２

３

２－５．アンインストール

第2章 : Android
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④アンインストールを実行する場合は、「アンインストール」
をタップして下さい。

⑤「このアプリをアンインストールしますか？」と
表示されますので「OK」をタップして下さい。
＊端末によって、確認メッセージが表示されない場合が

あります。

４

５

第2章 : Android
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1) Tap the icon of Play store on the Home screen of 
Android.

2) Tap “ ".

3) Enter "vApp" or "NTT Communications" and then 
perform searching.

4) Tap the [vApp] application.

<Supplemental Information>
The "Download vApp" screen on the App store opens even if 
the following URL is directly input on the Web browser.
URL→https://play.google.com/store/apps/details?id=com.ntt
.vapp

2-1. Installation

１

３

４

２

第2章 : Android
Chapter 2: Android
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5) Tap [INSTALL].

6) Tap [ACCEPT].

7) Tap [OPEN].
The application opens.
Installation work is complete.

<Note>
Be careful with products having similar application 
name.
Be sure to install NTT Communications' official 
application.

５

６

７

第2章 : Android
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Communication status 
* The IP address allocated by the server cannot be fixed.

User name used for connection

VPN Connect/ Disconnect button

Taskbar
- HOME...The Home screen appears.

- CONFIGURATION...The screen for adding, editing and 
deleting an account appears. The screen for setting 
options appears.

- SUPPORT…The screen where guidance of the support 
site is available and maintenance tool can be executed 
appears. The screen for executing the maintenance 
tool appears.

Automatic setting from the reception mail introduced in 
YouTube, etc. will be provided in the future. 

Configuration of the Home screen is as follows.

2-2. Setting

第2章 : Android
Chapter 2: Android

48

<Supplemental Information>
Home screen of vApp version 
v3.1.0 or above:

vApp widget of the Home screen 
differs from  old version.
* The function of vApp is same.
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1) Tap the icon of vApp on the Home screen of Android.

2) The Home screen of vApp appears.

3) Tap the [CONFIGURATION] tab.

2-2-1. How to Register the User ID

１

３

第2章 : Android
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4) Tap [Edit].

5) Tap [Add ID].

6) Enter a name.

7) Enter the user ID written on the E-mail for guidance.
* If user doesn’t know User ID, contact the IT administrator 

in your company.

４

６

５

７

第2章 : Android
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8) Tap the Default Connection as needed and then put a 
check mark.

* When adding the ID, there are 2 following methods 
other than operation described at (8):

… A． After performing the operation (9),
press and hold the user ID and then tap [Default ID]. 

…B． Select the user ID from the pulldown menu on the 
CONFIGURATION tab screen.

9) Tap [OK].

８

９

A

B

第2章 : Android
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10) "       " is added to the user ID configured for default 
connection.

11) Tap [               ]. ([Back] button on the terminal)

12) Change option setting if you need.
- Device Authentication Option(On/Off)

…This option(On) is needed when using The Device  
Authentication function.

(Refer to 2-2-3.) 

- Connect it at starting the application automatically(On/Off)
… When the application starts up, the screen for 

inputting password appears while the user ID that is 
configured for default connection  is selected.
(Refer to 2-3-1 (4).)

- Logging (On/Off)
… vApp connection log (Applog) can be acquired.

(Refer to 2-4 (5).)

13) Tap the [HOME] tab when the setting is complete.

13

11

12

10

第2章 : Android
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<Supplemental Information>
vApp version v3.1.0 or above:
Default mark is as follows.
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1) Tap the [CONFIGURATION] tab.

2) Tap [Edit] when deleting a user ID.

2-2-2. Modification of Settings of User ID (Deletion)

２

１

第2章 : Android
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3) Press and hold the user ID which needs to be deleted  
for 2 seconds.

4) Tap [Delete ID].

5) The message "Delete ID.Are you OK?" appears. 
Tap [OK].

５

４

３

第2章 : Android
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<Supplemental Information>
vApp version v3.1.0 or above:
Tap "         " , then menu appears.
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1) Tap the [CONFIGURATION] tab.

2) Put a check mark on the “Device Authentication 
Option”.

2-2-3. Settings of Device Authentication

２

１

第2章 : Android
Chapter 2: Android

*If you don't use function of device 
authentication, go to "2-3. VPN 
Connection/ Disconnection".
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3) The message "Are you sure you want to active the 
Device Authentication Option?" appears.
Tap [OK].

4) Tap the [SUPPORT] tab.

5) Tap [Get Device-ID].

３

第2章 : Android
Chapter 2: Android

４

5

<Caution>
Turn off the Device Authentication option when you don't use 
this function. 

When you have configured more than one vClient-ID and 
function of Device Authentication is enabled.  Function will be 
applied to all configured vClient-ID.
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6) Device-ID is displayed in the message.
*Device-ID：16 characters of letters and numbers.

7) If you would like to send the Device-ID by e-mail, tap 
[OK].

7

第2章 : Android
Chapter 2: Android

6

<Supplemental Information>
E-mail application will open and the Device-ID will be written 
in the message.
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1) Tap the icon next to "ID:" (underline) on the Home 
screen.

2) Select and tap the user ID.
(Example) ID: COM-ABC

3) Tap the [Connect] button on the Home screen.

2-3. VPN Connection/ Disconnection
2-3-1. Connection

３

１

２
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4) Enter the password.
* If password is unknown, 

contact the system administrator.

5) Tap [OK].

6) When the Warning screen appears, put a check mark 
on the "I trust this application." checkbox.

＊ This warning screen appears when establishing the 
VPN connection for the first time.

7) Tap [OK].

<Note>
If the password is different,
the following error message appears.

４

５

６

７
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8) If the connection is established, "      " is added.

9) The "Status" changes to "CONNECTED".

９

８

第2章 : Android
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1) Start up vApp and then tap the [Disconnect] button.

2-3-2. Disconnection

１

第2章 : Android
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1) Tap [                   ]. 
([Back] button on the terminal)

2) Tap [                   ]. 
(Tap the <Home>button on the terminal.)

3) Tap [                   ].
(<Recently used applications> button on the terminal)

* Icon marks may vary depending on terminals.
Perform operations according to terminal in use.

4) Swipe (slide) the vApp, which is being activated, to the 
left or right.

* Operations for exiting application may vary 
depending on terminals.

Perform operations according to terminal in use.

2-3-3. Exit

２１ ３

４
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1) Tap the [SUPPORT] tab on the Home screen.

* The following page describes each menu of the 
Support screen.１

2-4. Other supports

第2章 : Android
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1) Visit Support Site
… Jump to the Web site where support information, 

including usage of Arcstar Universal One Virtual 
vApp, is published.

2) Save Network Statistics
…Network information for device is acquired and 

stored if communication is stable or communication 
cannot be established.

3) Communication Test
... Check the communication status of the network.

(Ping/Traceroute/nslookup）

4) Get Device-ID
...Refer to 2-2-3.

5) Send Log Files
... By tapping this button, you can send an E-mail of 

information stored at (2) and (3).

6) Software License Agreement
... Software License Agreement appears.

7) Privacy Policy
... Privacy Policy appears.

8) About
... By tapping this button, you can check the version of 

Arcstar Universal One Virtual vApp in use.

* Each menu of the Support screen is as follows.

第2章 : Android
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(1) Visit Support Site

1) The Customer Support screen appears.

第2章 : Android
Chapter 2: Android
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1) The screen for acquiring the communication status 
appears. Tap [OK].

(2) Save Network Statistics

１

第2章 : Android
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1) Tap the underline of Ping.
The pulldown menu appears.

2) Select and tap the appropriate option from "Ping", 
"Traceroute" and "nslookup".
* Refer to the next page for the usage detail.

(3) Communication Test

２

１

第2章 : Android
Chapter 2: Android

<Note>
Showing “Ping” and “Traceroute” depends on using 
device type.
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1) Tap the underline of Ping and select an appropriate option 
from the pulldown menu.

2) Enter the IP address/ host name.
(Example) www.ocn.jp

3) Tap [Go].

4) The result start to appear on the screen. 
Wait until log stops.

5) Tap [Save Log File].

6) By tapping [Save Log File], the message "Log File has been 
saved" appears.
Tap [OK].

●Operation procedures●

１

２

３

４

６
５
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The log file acquired at (2) and (3) appears on the screen 
for sending support information. 

1) Select and tap the appropriate file from log files to
make the background gray.
* Multiple log files can be selected.
* The display order is ascending order of file names.
* Details of log

[NWLog]
Condition for Log acquisition: (2) Save Network Statistics.
Maximum number of retained logs: 5 pieces
File name: Year Month Date_Hour Minute Second_NWLog_ android

↓
In the case of the time is 12:34 56 seconds on April 1, 2014 , 

file name will be like “140401_123456_NWLog_android”.
[TestLog]

Condition for Log acquisition:(3) Communication Test
Maximum number of retained logs: 5 pieces
File name: Year Month Date_Hour Minute Second _TestLog_android

↓
In the case of the time is 12:34 56 seconds on April 1, 2014 , 

file name will be like “140401_123456_ TestLog_android”.
[AppLog]

Condition for Log acquisition: During communication
* Only if the Logging option is set to "ON“:

Maximum number of retained logs: 3 pieces (for 3 days)
File name: Year Month Date_AppLog_iOS

↓
In the case of April 1, 2014, file name will be like 

"140401_AppLog_android”.

2) Tap [OK].

(5) Send Support Info

１

２

第2章 : Android
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3) The mailer opens and an E-mail is created.
All of the selected logs appear in the body text of 
an E-mail.

4) Tap [To], [Subject] and enter these items.

5) Tap [          ] to send the support information.
* Operations vary depending on terminals.

Perform operations according to mailer in use.

４

５

３

第2章 : Android
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1) The version of application appears.
Tap [OK].

(8) About

１

第2章 : Android
Chapter 2: Android
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1) Open the screen for setting the terminal.

2) Tap [Apps].

3) Tap [vApp].

2-5. Uninstallation

２

３

第2章 : Android
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4) When executing uninstallation, tap [Uninstall].

5) The message "Do you want to uninstall this app?" 
appears. In this case, tap [OK].  

* Confirmation message may not appear depending on 
terminals.

４

５
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第3章 : iOS

Chapter 3: iOS
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①iOSのホーム画面から
App Storeのアイコンをタップして下さい。

１

３－１．インストール

第3章 : iOS
Chapter 3: iOS
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②「 」をタップします。

③検索バーに「vApp」もしくは
「NTT communications」と入力し、検索して下さい。

④「vApp」アプリを選択し、「無料」を
タップして下さい。インストールに変わります。

⑤「インストール」をタップして下さい。

⑥AppleIDのパスワードを入力して下さい。

⑦「OK」ボタンをタップして下さい。

⑧「開く」をタップして下さい。
以上でインストールは完了です。

６

７

● ● ● ● ● ntt.com

＜注意＞
アプリ名が類似している商品にご注意ください。
必ず、NTTコミュニケーションズ公式のものを
インストール願います。

２

３

４
vApp        

５
vApp        

８
vApp

＜補足＞
Webブラウザに以下のURLを直接入力した場合も、
Appストア上のvAppダウンロード画面へ遷移できます。
※バージョンやAppStoreに設定している国によって、

URLからダウンロードできない場合があります。
URL→https://itunes.apple.com/us/app/vapp/id839
416460?l=ja&ls=1&mt=8

第3章 : iOS
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ホーム画面の構成については下記の通りです。

接続するユーザ名

VPNの接続/切断ボタン

タスクバー
・ホーム・・・ホーム画面を表示します。

・設定・・・・アカウントの追加や編集・削除、
オプションの設定を行う画面を
表示します。

・サポート・・サポートサイトへの案内や
保守ツールを実行できる画面を
表示します。

Youtube等で紹介している受信メールからの
自動設定は今後提供予定です。

VPN通信中のIPアドレスを確認する場合

iOSのホーム画面で「設定」をタップし、設定内の「VPN」、「状況」と続けてタップします。
「状況」の一番下に「IPアドレス」が表示されます。

※割当てられたIPアドレスは固定できません。

３－２．設定

第3章 : iOS
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①iOSのホーム画面から
vAppのアイコンをタップして下さい。

②vAppのホーム画面が表示されます。

③設定タブをタップします。

３

１

３－２－１．ユーザID登録方法

第3章 : iOS
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④「未設定」をタップして下さい。

⑤「ID追加」をタップして下さい。

４

５
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⑥任意の名前を入力して下さい。

⑦接続案内メール記載のユーザIDを入力して下さい。
※ユーザIDが分からない場合、

システム管理者へ確認してください。

⑧ 「保存」をタップし、ID設定画面に遷移します。
*IDが複数存在の場合、デフォルト接続IDを選択できます。

６

８

７
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＜注意＞
iOS8以降のバージョンの端末をご利用の場合、
オプション設定の「接続設定」をオンにして下さい。
※オフの場合、接続できません。

⑨「設定」をタップして下さい。
設定画面に遷移します。

⑩必要に応じてオプション設定を変更して下さい。
・アプリ起動時にVPN有効化 (オン/オフ)

…アプリを起動すると、初期選択値に設定した
ユーザIDが選択された状態で、パスワード入力画面が
表示されます。(詳細は、3-3-1④参照)

・ログ保存 (オン/オフ)
…AppLogを取得します。(詳細は、3-4-(5)参照)

・機体認証オプション (オン/オフ)
…機体認証機能の利用有無を選択します。
(詳細は、3-2-3参照)

⑪設定が完了したらホームタブをタップして下さい。

11

10 

9
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①設定タブをタップして下さい。

②「ユーザID」をタップして下さい。

１

２

３－２－２．ユーザID設定変更（削除）

第3章 : iOS
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③ユーザIDを削除したい場合は「編集」をタップして下さい。

④削除したいユーザIDの「 」をタップすると、
右側から「削除」が表示されます。

⑤「削除」をタップして下さい。

⑥「完了」をタップして下さい。

３

６

４

５
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①設定タブをタップして下さい。

②「機体認証オプション」をオンにして下さい。

１

２

３－２－3．機体認証機能の設定

第3章 : iOS
Chapter 3: iOS

※機体認証機能を利用しない場合、
3－3. VPN接続／切断へ進みます。
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③確認メッセージが表示されます。
「OK」をクリックして下さい。

④サポートタブをタップして下さい。

⑤「端末識別IDの取得表示」をタップして下さい。

３

４

５

第3章 : iOS
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＜注意＞
機体認証オプションを利用しない場合は、オプションを無
効にして下さい。

機体認証オプションが「オン」の場合、vAppに登録された
すべてのユーザIDに適用されます。
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⑥取得した端末識別ID(半角英数16字)は、お客様自身でシステム
管理者へ連絡して下さい。

⑦端末識別IDをメール送信する場合は、「OK」をタップします。

第3章 : iOS
Chapter 3: iOS

６

7

＜注意＞
vAppのアンインストール等を行った場合、端末識別ID
が変わる場合がございます。
再インストール後は、必ず端末識別IDを再取得し、シ
ステム管理者へご連絡ください。

＜補足＞
メーラーが立ち上がり、メールの本文に端末識別IDが記
載されたメールが作成されます。
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①ホーム画面で「ID」の横（ ＞）をタップして
下さい。

②ユーザIDを選択してタップして下さい。
（例）ID：コム太郎

③「VPNアカウント有効化」をオンに切り替えて
下さい。

④パスワード入力を要求するメッセージが表示されるので
パスワードを入力します。
※パスワードが分からない場合、

システム管理者へ確認してください。

⑤「OK」をタップして下さい。

４

５

＜注意＞
パスワードが違う場合
以下のようなエラーが表示されます。

１

３

２

３－３．VPN接続／切断
３－３－１．接続

第3章 : iOS
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⑥構成プロファイルを設定取得するか尋ねられます。
＊左図が表示されてから、5分以内にVPN接続操作を

行って下さい。

※初回利用の場合
…「設定取得」をタップして下さい。

構成プロファイルのインストールが開始されるため、
画面の指示に従いインストールを実行して下さい。

※既に構成プロファイルを設定取得した場合
…構成プロファイルの設定取得は不要です。

「OK」をタップして下さい。

※事前共有鍵を更新した場合や、弊社設備にて
メンテナンス工事を行った場合には構成プロファイルを
再取得する必要があります。
その場合、必ず前回の構成プロファイルを削除した上で、
新たに構成プロファイルを取得してください。
詳細は、P.90の[補足]を参照してください。

⑦端末のホームボタンを押下し、
iOSのホーム画面に戻ります。

６

７

第3章 : iOS
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⑧iOSのホーム画面で「設定」をタップして下さい。

⑨「VPN」をタップして下さい。

９

８

第3章 : iOS
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⑩ 「VPN」を「オン」に切り替えて下さい。

⑪VPNが「オン」に切り替わり、インフォメーションバーに
「VPN」の表示がされます。

⑫状況が「接続中」に切り替わります。

10

11

12

第3章 : iOS
Chapter 3: iOS

90

＜補足＞
iOS端末にインストールされたプロファイルを削除する方法は以下の通りです。

① iOSの「設定」メニューにて、「一般」＞「プロファイル」とタップして下さい。
② 端末にインストールされたプロファイル一覧が表示されるので、削除したいプロファイルをタップして下さい。
③プロファイルの詳細画面が表示されるので、画面下部の「プロファイルを削除」をタップして下さい。

1

2

3
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①iOSのホーム画面で「設定」をタップして下さい。

②「VPN」をタップして下さい。

１

２

３－３－２．切断

第3章 : iOS
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③ VPNを「オフ」に切り替えて下さい。
＊vAppの起動は必要ありません。

３

第3章 : iOS
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①端末のホームボタンを素早く2回押下します。

②起動中のvAppを上へスワイプ（スライド）
して下さい。

３

１

３－３－３．終了

第3章 : iOS
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①ホーム画面のサポートタブをタップして下さい。

＊次ページにサポート画面の各メニューについて
説明があります。

１

３－４．その他サポート

第3章 : iOS
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サポート画面の各メニューについては下記のとおりです。

(1)サポートサイト
…Arcstar Universal One Virtual vAppのご利用方法などの

サポート情報を掲載したサイトへジャンプします。

(2)通信状態の取得
…通信が不安定や接続できない場合などにデバイスのネットワー

ク情報を取得・保存します。

(3)通信テスト
…ご利用のネットワークの通信状態を確認することができます。

（Ping/Traceroute/nslookup）

(4)端末識別IDの取得表示
…詳細は、3-2-3参照。

(5)ログの送信
…(2) (3)で保存した情報をメールで送信することができます。

(6)ソフトウェア使用許諾契約書
…ソフトウェアの使用許諾契約書を表示します。

(7)プライバシーポリシー
…プライバシーポリシーを表示します。

(8)このアプリについて
…ご利用中のArcstar Universal One Virtual vAppのバージョン

を確認することができます。

第3章 : iOS
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(1)サポートサイト

①お客さまサポート画面が表示されます。

第3章 : iOS
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①通信状態の取得画面が表示されます。
「OK」をタップして下さい。

(2)通信状態の取得

１

第3章 : iOS
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①「 」をタップして下さい。
プルダウンされます。

②プルダウンされた３種類の「Ping」「Traceroute」
「nslookup」の中から該当するものを選択して
タップして下さい。
＊次ページで操作方法の流れを説明しています。

１

２

(3)通信テスト

第3章 : iOS
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４

５

①「 」をタップし、プルダウンから該当するものを選択して
下さい。

② IPアドレス／ホスト名を入力して下さい。
（例）www.ocn.jp

③「実行」をタップして下さい。

④ログが表示されます。しばらくお待ちください。

⑤「ログに保存」をタップして下さい。

⑥「ログを保存しました」と表示されます。
「OK」をタップして下さい。

６

２

３

●操作方法●

１

第3章 : iOS
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(4)ログの送信画面に、
(2) 、(3)で取得したログファイルが表示されます。

①ログファイルの中から該当するものを選択して
タップをすると背景色が灰色になります。
＊複数選択出来ます。

＊表示順は、NWLog、AppLog、TestLogの順で。

＊ログの詳細
【 NWLog 】

取 得 条 件 ：(2)通信状態の取得
最大保持数 ：5個
ファイル名 ：年月日_時分秒_NWLog_iOS

↓
2014/4/1の12:34 56秒の場合

(例) 140401_123456_NWLog_iOS
【 TestLog 】

取 得 条 件 ：(3)通信テスト
最大保持数 ：5個
ファイル名 ：年月日_時分秒_TestLog_iOS

↓
2014/4/1の12:34 56秒の場合

(例) 140401_123456_ TestLog_iOS
【 AppLog 】

取 得 条 件 ：通信時
＊ログ保存が「オン」の場合のみ

最大保持数 ：3個 (3日分)
ファイル名 ：年月日_AppLog_iOS

↓
2014/4/1の場合

(例) 140401_AppLog_iOS

②「 」をタップして下さい。

１

２

(5)サポート情報の送信
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③ メーラーが立ち上がり、メールが作成されます。
メールの本文には、選択したログがすべて表示されます。

④「宛先」「Cc/Bcc」「件名」をタップし、
それぞれ入力して下さい。

⑤「送信」をタップして送信して下さい。

※メール送信する際は、インターネット接続できること
を確認してから送信願います。
仮想ネットワークからインターネットへ接続できる環境
でない場合は、一度仮想ネットワークを切断の後、メー
ル送信願います。

３

４

５
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①アプリのバージョンが表示されます。
「OK」をタップして下さい。

１

(8)このアプリについて

第3章 : iOS
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①iOSのホーム画面で、vAppを2秒程長押しして下さい。

②アイコンが揺れ、左上に×印が表示されます。
×印をタップして下さい。２

１

３－５．アンインストール

第3章 : iOS
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③削除の確認メッセージが表示されます。
アンインストールを実行する場合は、「削除」をタップして
下さい。

３
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1)Tap the App Store icon on the Home screen.

3-1. Installation

１

第3章 : iOS
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2) Tap “ ".

3) Enter "vApp" or "NTT Communications" and then 
perform searching.

4) Select "vApp" and then tap [FREE].
Installation starts.

5) Tap [INSTALL].

6) Enter the password of AppleID.

7) Tap the [OK] button.

8) Tap [Open].
Installation work is complete.

<Note>
Be careful with products having similar application name.
Be sure to install NTT Communications' official application.

<Supplemental Information>
The "Download vApp" screen on the App store opens even if the 
following URL is directly input on the Web browser.
* vApp may not be downloaded from the URL depending on 
versions and countries where AppStore is set.
URL→https://itunes.apple.com/us/app/vapp/id839416460?l=ja
&ls=1&mt=8

６

７

xxxxxxxxx@ntt.com

２

４

５

８

３
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User name used for connection

VPN Connect/ Disconnect button

Taskbar
- Home...The Home screen appears.

- Configuration ... The screen for adding, editing and 
deleting an account appears.

- Support…The screen where guidance of the support 
site is available and maintenance tool can be executed 
appears.

Automatic setting from the reception mail introduced in 
YouTube, etc. will be provided in the future. 

3-2. Setting
Configuration of the Home screen is as follows.

Checking an IP address used for VPN connection.

Tap [Settings] on the Home screen of iOS and then tap [VPN] > [Status] in the setting.
The "IP Address" appears at the bottom of [VPN].

* The IP address allocated by the server cannot be fixed.

第3章 : iOS
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1) Tap the icon of vApp on the Home screen of iOS.

2) The Home screen of vApp appears.

3) Tap the [Configuration] tab.

3-2-1. How to Register the User ID

３

１
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4) Tap [Not Set].

5) Tap [Add ID].

４

５
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6) Enter a name.

7) Enter the user ID written on the E-mail for guidance.
* If user doesn’t know User ID, contact the IT administrator 

in your company.

8) Tap [Save].
The ID Setting screen appears.
* When there are plural ID, you can select default ID.

６

８

７
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<Note>
When using the terminal equipped with iOS8 or later, 
"Connection setting" is ON.

* No connection can be established if OFF is set.

9) Tap [Configuration].
The Setting screen appears.

10) Change option setting if you need.
- Account Enable on Start(ON/OFF)

...When the application starts up, the screen for 
inputting password appears while the user ID is 
selected. (Refer to 3-3-1 (4).)

- Logging (ON/OFF)
… vApp connection log (Applog) can be acquired. 

(Refer to 3-4-(5).)

- Device Authentication Option (ON/OFF)
…This option(On) is needed when using the Device  

Authentication function. (Refer to 3-2-3.)

11) Tap the [Home] tab when the setting is complete.

11

10 

9
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1) Tap the [Configuration] tab.

2) Tap [User ID].

3-2-2. Modification of Settings of User ID (Deletion)

１

２
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3) Tap [Edit] when deleting a user ID.

4) IF [      ] for the user ID to be deleted is tapped,
"Delete" appears at the right.

5) Tap [Delete].

6) Tap [Done].

３

６

４

５
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1) Tap the [Configuration] tab.

2) Switch [Device Authentication Option] ON. 

第3章 : iOS
Chapter 3: iOS

If you don't use function of device 
authentication, go to “3-3. VPN 
Connection/ Disconnection".

3-2-3. Settings of Device Authentication

１

２
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３

４

５
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3) The message "Are you sure you want to active the Device 
Authentication Option?" appears.
Tap [OK].

4) Tap the [Support] tab.

5) Tap [Get Device-ID].

<Caution>
Turn off the Device Authentication option when you don't use this 
function. 

When you have configured more than one vClient-ID and function 
of Device Authentication is enabled.  Function will be applied to 
all configured vClient-ID.
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６

7

6) Device-ID is displayed in the message.
*Device-ID：16 characters of letters and numbers.

7) If you would like to send the Device-ID by e-mail, tap [OK].

<Note>
When reinstalling vApp, the Device-ID will be changed.
In that case, you need to get Device-ID again and inform new 
Device-ID to System Administrator.

<Supplemental Information>
E-mail application will open and the Device-ID will be written 
in the message.
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1) Tap the icon next to "ID" (>) on the Home screen.

2) Select and tap the user ID.
(Example) ID: COM-ABC

3) Switch [Enable VPN Account] ON.

4) When the message requesting input of password 
appears, input the password.

* If password is unknown, contact the system 
administrator.

5) Tap [OK].

<Note>
If the password is different, the following error message appears.４

５

１

３

２

3-3. VPN Connection/ Disconnection
3-3-1. Connection
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(6) The message asking you whether to acquire setting of 
the configuration profile appears.

* Operation for establishing connection must be done 
within 5 minutes after the figure at left appears.

* When using the service for the first time
....Tap [Get Profile].

Installing the iOS configuration profile starts;
therefore be sure to install the configuration profile 
according to the instruction on the screen.

* When the configuration profile is already set and 
acquired:

...Acquisition of setting of the configuration profile is 
not required.

Tap "OK".

*After our equipment maintenance or the pre-shared
key is changed by the administrator,  the configuration 
profile needs to be acquired again.
In that situation, please delete the configure profile 
which is already set first, then re-install a new 
configure profile.

(7) Tap the [Home] button on the terminal to 
return to the Home screen of iOS.

６

７
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8) Tap [Settings] on the Home screen of iOS.

9) Tap [VPN].

９

８
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10) Switch “Connected" to "ON".

11) VPN is set to "ON" and "VPN" appears on the 
Information bar.

12) The status is changed to "Connected".

10

11

12
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1) Tap [Settings] on the Home screen of iOS.

2) Tap [VPN].

3-3-2. Disconnection

１

２
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3) Switch “Connected" to "OFF".
* vApp  does not need to start up.

３
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1) Tap the [Home] button on the terminal twice quickly.

2) Swipe (slide) the vApp, which is being activated, 
upward.

3-3-3. Exit

2

１
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1) Tap the [Support] tab on the Home screen.

* The following page describes each menu of the 
Support screen.

3-4. Other supports

１
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1) Visit Support Site
…Jump to the Web site where support information, 

including usage of Arcstar Universal One Virtual vApp, 
is published. 

2) Save Network Statistics
…Network information for device is acquired and 

stored if communication is stable or 
communication cannot be established.

3) Communication Test
…Check the communication status of the network.

(Ping/Traceroute/nslookup）

4) Get Device-ID
…Refer to 3-2-3.

5) Send Log Files
…By tapping this button, you can send an E-mail of 

information stored at (2) and (3).

6) Software License Agreement
…Software License Agreement appears.

7) Privacy Policy
…Privacy Policy appears.

8) About
…By tapping this button, you can check the version of 

Arcstar Universal One Virtual vApp in use.
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1) The Customer Support screen appears.

(1) Visit Support Site

第3章 : iOS
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1) The screen for acquiring the communication status 
appears. Tap [OK].

(2) Save Network Statistics

１
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1) Tap [     ].
The pulldown menu appears.

2) Select and tap the appropriate option from "Ping", 
"Traceroute" and "nslookup".
* Refer to the next page for the usage detail.

１

２

(3) Communication Test
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1) Tap [     ] and select the appropriate option.

2) Enter the IP address/ host name.
(Example) www.ocn.jp

3) Tap [Go].

4) The result start to appear on the screen. 
Wait until log stops.

5) Tap [Save Log].

6) By tapping [Save Log], the message "Log has been saved." 
appears.
Tap "OK".

４

５

６

２

３

１

●Operation procedures●
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The log file acquired at (2) and (3) appears on the (4) screen for 
sending the log.

1) Select and tap the appropriate file from log files to 
make the background gray.
* Multiple log files can be selected.
* Display order is NWLog, AppLog and TestLog.
* Details of log

[NWLog]
Condition for Log acquisition: (2) Save Network Statistics 
Maximum number of retained logs: 5 pieces
File name: Year Month Date_Hour MinuteSecond_NWLog_iOS

↓
In the case of the time is 12:34 56 seconds on April 1, 2014, file 

name will be like "140401_123456_NWLog_iOS”.
[TestLog]

Condition for Log acquisition: (3) Communication Test 
Maximum number of retained logs: 5 pieces
File name: Year Month Date_Hour Minute Second_TestLog_iOS

↓
In the case of the time is 12:34 56 seconds on April 1, 2014, file 

name will be like "140401_123456_ TestLog_iOS”.
[AppLog]

Condition for Log acquisition: During communication
* Only if the Logging option is set to "ON“:

Maximum number of retained logs: 3 pieces (for 3 days)
File name: Year Month Date_Hour Minute Second_AppLog_iOS

↓
In the case of April 1, 2014, file name will be like 

"140401_AppLog_iOS”.

2) Tap [        ].

２

(5) Send Log Files

１
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3) The mailer opens and an E-mail is created.
All of the selected logs appear in the body text of 
an E-mail.

4) Tap [To], [Cc/Bcc] and [Subject], respectively.

5) Tap [Send] to send the support information.

* When sending an E-mail, send the mail after 
confirming that Internet can be established. 

If the condition does not allow establishment of 
Internet connection from the virtual network, be 
sure to send an E-mail after disconnecting the 
virtual network once.

３

４

５
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1) The version of application appears.
Tap [OK].

(8) About

１
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1) Press and hold [vApp] on the Home screen of iOS for 2 
seconds.

2) The icon shakes and the X mark appears at the top left. 
Tap the X mark.

3-5. Uninstallation

２

１
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3) The message for confirming deletion appears.
When installation executes, tap [Delete].

３
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① Arcstar Universal One Virtual のサポートサイト
を表示し、vApp(Windows)をダウンロードします。

サポートサイトURL→http://support.ntt.com/

②ダウンロードした「 vApp_XXX.exe」を
右クリックして下さい。

③「管理者として実行」をクリックして下さい。

④インストールで使用する言語を選択して「OK」を
クリックして下さい。

2

４－１．インストール

＜注意＞
管理者として実行しない場合、インストール
エラーが発生したり、インストールできても
実行エラーが発生する恐れがあります。

3

4

＊Microsoft .NET Framework 3.5 と 4.5がお使いの
パソコンにインストールされていない場合に、
「InstallShield Wizard」が起動しますので、
『4-1 インストール』を参照しながら
インストールを進めて下さい。
しばらくそのまま待ちます。

※インストールが既に完了している場合、
4-2.設定 へ進みます。

第4章 : Windows
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⑤ソフトウェア使用許諾契約の条項を読み、
問題がなければ「同意します」を選択して下さい。

⑥「次へ」をクリックして下さい。

⑦左画面が表示されたら「次へ」をクリックします。

⑧左画面が表示されたら「インストール」をクリック
して下さい。

6
5

7

8
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⑨左画面が表示されたら「完了」をクリックして下さい。
以上でインストール作業は終了です。

9

＜注意＞
インストールできない場合は、お使いのOSのバージョンや手順等を再度ご確認ください。

＜注意＞
端末によっては「サービス呼び出しに失敗しました（330）」とエラーが出るものがあります。
またvApp(Windows)の動作に必要なソフトウェアがインストールされていない場合、「エラー
1722」が表示されることがあります。

いずれの場合も、vAppをアンインストールをした後、下記URLから
「Microsoft Visual C++ 2010 SP1 再頒布可能パッケージ(x86)」のインストールをお願いします。

URL→http://www.microsoft.com/ja-jp/download/details.aspx?id=8328

その後、再度vAppのインストールを実施願います。

第4章 : Windows
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①「スタートメニュー」から「すべてのプログラム」
を選択し、「vApp」をクリックして下さい。

ホーム画面の構成については下記の通りです。

１vApp

接続するユーザ名

ツールバー
・メニュー・・アカウントの追加や編集・削除、

オプションの設定を行う画面を
表示します。

・サポート・・サポートサイトへの案内や
保守ツールを実行できる画面を
表示します。

VPNの接続/切断ボタン

接続状態

サーバから割当てられたIPアドレス
※割当てられたIPアドレスは固定できません。

接続時間

４－２．設定

＜補足＞
画面の最小化をクリックすると、タスクトレイに格納されます。

第4章 : Windows
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①ツールバーの「メニュー」から「設定」をクリック
して下さい。

②アカウントタブをクリックし、
「追加」をクリックして下さい。

③任意の名前を入力して下さい。

４－２－１．ユーザID登録方法

3

１

2
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コム太郎

④接続案内メール記載のユーザIDを入力して下さい。
※ユーザIDが分からない場合、

システム管理者へ確認してください。

⑤「OK」をクリックします。

⑥必要に応じてデフォルト接続に設定したい
ユーザIDを選択し、デフォルト接続を設定して下さい。

⑦必要に応じてログ設定タブをクリックし、オプション
設定を変更して下さい。
・接続ログを保存する(オン/オフ)

… AppLogを取得します。
(詳細は、4-4-(2)の<補足>参照)

⑧「OK」をクリックします。

5

4

6

7

8
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①ツールバーの「メニュー」から「設定」をクリック
して下さい。

②アカウントタブをクリックし、削除したいユーザIDを
選択します。

③「削除」をクリックします。
＊デフォルト接続に設定されているユーザIDは

削除不可です。他のユーザIDをデフォルト接続に
設定してから操作を行って下さい。

④「OK」をクリックします。

４－２－２．ユーザID設定変更（削除）

１

2

3

4
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①ツールバーの「メニュー」から「設定」をクリック
して下さい。

②オプション設定タブをクリックし、機体認証オプショ
ンをオンにして下さい。

③確認メッセージが表示されます。
「OK」をクリックして下さい。

４－２－３．機体認証機能の設定

第4章 : Windows
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1

2

3

※機体認証機能を利用しない場合、
4－3. VPN接続／切断へ進みます。

＜注意＞
機体認証オプションを利用しない場合は、オプ
ションを無効にして下さい。

機体認証オプションが「オン」の場合、vAppに登
録されたすべてのユーザIDに適用されます。
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④「OK」をクリックします。

⑤ツールバーの「サポート」から「端末識別IDの取得表
示」をクリックして下さい。

⑥取得した端末識別ID(半角英数16字)は、お客様自身で
システム管理者へ連絡して下さい。

⑦端末識別IDをファイルに保存する場合は、「はい」を
クリックします。

第4章 : Windows
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4

5

6

7 【 端末識別ID 】
ファイル名：vapp_hardware_id.txt
保 存 場 所 ：デスクトップ
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又は

①ツールバーの「メニュー」から「接続」をクリック
又は
「OFF」ボタンをクリックして下さい。

＊初期設定がされていない場合、初期設定画面が
開きます。
「4-2-1 ユーザID登録方法」を確認し、設定を行っ

て下さい。

②パスワードを入力します。
※パスワードが分からない場合、

システム管理者へ確認してください。

③「接続」をクリックして下さい。

④サーバへ接続中です。左画面が表示されている間は、
しばらくお待ち下さい。

⑤接続に成功すると、VPNの接続/切断ボタンが
「ON」に切り替わります。

⑥「接続状態」が「接続」に切り替わります。

⑦タスクトレイのアイコンから「vApp接続」の
吹き出しが表示されます。

３

２

7

４－３．VPN接続／切断
４－３－１．接続

１

5

6

１

第4章 : Windows
Chapter 4: Windows

145



(C) NTT Communications All Rights Reserved

Go to Index

又は

①ツールバーの「メニュー」から「切断」をクリック
又は
「ON」ボタンをクリックして下さい。

②切断中です。左画面が表示されている間は、
しばらくお待ち下さい。

③VPNの接続/切断ボタンが「OFF」に切り替わります。

④「接続状態」が「未接続」に切り替わります。

⑤タスクトレイのアイコンから「vApp未接続」の
吹き出しが表示されます。

※エラーが発生した場合※
・「P150→ 通信状態の取得」をご参考頂きログファイルを保存し、テキストの内容をメールに

貼り付け、システム管理者へご報告ください。
その後、ビジネスポータルにて弊社サポート窓口までお問合せ願います。

5

４－３－２．切断

１

１

3

4
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①ホーム画面右上の×印をクリック
又は
ツールバーの「メニュー」から「終了」をクリック
して下さい。

②終了の確認メッセージが表示されます。
「OK」をクリックして下さい。

又は

２

４－３－３．終了
１

１
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①ツールバーの「サポート」をクリックして下さい。

＊次ページにサポート画面の各メニューについて
説明があります。

４－４．その他サポート

１
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(1)サポートサイト
… Arcstar Universal One Virtual 

vAppのご利用方法などの
サポート情報を掲載したサイトへ
ジャンプします。

(2)通信状態の取得
…通信が不安定や接続できない場合

などにデバイスのネットワーク
情報を取得・保存します。

(3)端末識別IDの取得表示
…詳細は、4-2-3参照

(4)通信テスト
…ご利用のネットワークの通信状態

を確認することができます。
（ping/traceroute/nslookup）

(5)更新の確認
…アプリケーション更新の有無を

確認できます。

(6)バージョン情報
…ご利用中のArcstar Universal 

One Virtual vAppのバージョンを
確認することができます。

サポート画面の各メニューについては下記のとおりです。

第4章 : Windows
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＜注意＞
アプリケーションをバージョン
アップした場合、アプリに登録
されているユーザIDが削除され
る可能性があります。
バージョンアップ前にユーザID
を控えて下さい。
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①ツールバーの「サポート」から「サポートサイト」を
クリックして下さい。

②お客さまサポート画面が表示されます。

(1)サポートサイト

１
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①ツールバーの「サポート」から「通信状態の取得」
をクリックして下さい。

②任意のフォルダとファイル名を指定し、保存して
下さい。

初期ファイル名：yyyymmdd(年月日)_log.txt

(2)通信状態の取得

１

２

第4章 : Windows
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＜補足＞
【 AppLog 】の取得について

取 得 条 件 ：通信時
＊接続ログを保存するが「オン」の場合のみ

ファイル名 ：sipd-年月日_log
↓

2014/4/1の場合
(例) sipd-20140401_log

保 存 場 所 ：
※OSのバージョンによってログが保存される場所が異なります。
※2点のログはいずれも同じファイル名で保存されるため、適宜名前を変更してお送りください。

【 32bitの場合】
１個目 → Cドライブ > Program Files > NTT Communications > vApp
２個目 → Cドライブ > Windowsフォルダ > System32フォルダ

【 64bitの場合】
１個目 → Cドライブ > Program Files(x86) > NTT Communications > vApp
２個目 → Cドライブ > Windowsフォルダ > SysWow64フォルダ

151



(C) NTT Communications All Rights Reserved

Go to Index

①ツールバーの「サポート」から「通信テスト」を
クリックして下さい。

②「▼」をクリックして下さい。
プルダウンされます。

③プルダウンされた３種類の「ping」「traceroute」
「nslookup」の中から該当するものを選択して
クリックして下さい。
＊次ページで操作方法の流れを説明しています。

(4)通信テスト

１

２

3
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① IPアドレス／ホスト名を入力して下さい。
（例）www.ocn.jp

②「実行」をクリックして下さい。

③ログが表示されます。しばらくお待ちください。

④「ログに保存」をクリックして下さい。

⑤任意のフォルダとファイル名を指定し、保存して
下さい。

初期ファイル名：yyyymmdd_hhmmss_
NW_TestLog_windows.txt

●操作方法●

＜補足＞
・yyyymmdd…年月日
・hhmmss…時分秒

1

3

24

5
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①ツールバーの「サポート」から「更新の確認」を
クリックして下さい。

②ソフトウェア更新の確認画面に「ソフトウェアの
更新を確認中」「更新をダウンロードしています」
が表示されます。
「OK」をクリックして下さい。

③最新のバージョンが表示されます。
＊更新がある場合は、「4-6その他」を

参照して下さい。

２

(5)更新の確認

１
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＜注意＞
アプリケーションをバージョンアップした場合、
アプリに登録されているユーザIDが削除される
可能性があります。
バージョンアップ前にユーザIDを控えて下さい。
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①ツールバーの「サポート」から「バージョン情報」
をクリックして下さい。

②アプリのバージョンが表示されます。
「OK」をタップして下さい。

(6)バージョン情報

１

２
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①アプリが起動中の場合は、アプリを終了します。
＊タスクトレイにアイコンがある場合は、起動中です。

「4-3-3終了」を確認し、アプリを終了して下さい。

②「コントロールパネル」から
「プログラムのアンインストール」をクリックします。
＊OSのバージョンによって、操作が異なります。

ご使用のOSに従って操作を行ってください。

③「vApp」をダブルクリックします。

④「vAppをアンインストールしますか？」と表示され
ますので「はい」をクリックします。

２

１

４

３

<タスクトレイにアイコンがある場合＞
４－５．アンインストール
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⑤アンインストールが開始されます。左画面が
表示されている間は、しばらくお待ちください。

⑥アンインストール中です。
左画面が表示されている間は、
しばらくお待ちください。

＊コントロールパネルから
プログラムの追加と削除を開き、
「vApp」と「Ubiquitous Client Virtual NIC」が
表示されないことを確認します。

＊コントロールパネルの「システム」から
システムのプロパティを開き、
「ハードウェア」タブの「デバイスマネージャ」を
選択します。
デバイスマネージャの「ネットワークアダプタ」に
「VNiC Driver」が表示されていないことを
確認します。
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2

①vAppを起動した際に、ソフトウェア更新の確認
画面が表示され、更新が必要な場合は「ソフト
ウェア更新の確認」が表示されます。

②ソフトウェア更新の確認画面と「ソフトウェアの
更新を確認中」が表示されます。
ソフトウェア更新の確認画面で「OK」をクリック
して下さい。

③アップデートを受信中が表示されます。

④「OK」をクリックします。

４

１

４－６．その他
４－６－１．アップデート
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1) Access Arcstar Universal One Virtual support site.
http://support.ntt.com/

Then, download the vApp(Windows) on the site.2

3

4

5

<Note>
If you don’t run as an administrator, an installation 
error will occur. Or, an execution error might occur 
even if installation completes.

2) Right-click “vApp_XXX/exe” which was downloaded.

3) Click “Run as an administrator”.

4) Select the language to be used while installing, then 
click "OK".

If Microsoft .NET Framework 3.5 and 4.5 are not installed 
on the PC in use, "InstallShield Wizard" activates and 
proceed to install while referring to "4-1 Installation".  
Wait for a while.

If installation is already completed, proceed to "4-2. 
Setting".

5) Click “Next”.

4-1. Installation

第4章 : Windows
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6) Read articles in the Software License Agreement, then 
select “I accept the terms in the license agreement" 
when there’re no problem.

7) Click “Next”.

8) Click "Next" when the screen on the left appears.

9) Click "Next" when the screen on the left appears.

8

9

7

6
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10) Click "Next" when the screen on the left appears. 
Installation work is complete.

<Note>
If software cannot be installed, check version and procedure in use again.

<Note>
An error "Service call failed (330)" may appear depending on devices.
In this case, install "Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)“ from the 
following URL after uninstalling vApp.
URL→ http://www.microsoft.com/en-za/download/details.aspx?id=5555

Then, install vApp again.

10
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1) Select "Start" menu > "All Programs", then click 
"vApp".

Configuration of the Home screen is as follows.

User name used for connection

Toolbar
- Menu ...Add, edit or delete an account.
The screen for setting options appears.

- Support..The screen where guidance of the 
support site is available and maintenance tool 
can be executed appears.

VPN Connect/ Disconnect button

Connection status

IP address allocated by the server *IP address is 
not allowed statically.

Connection time

4-2. Setting

<Supplemental Information>
When "Minimize" is clicked, the screen is stored in the task tray.

１
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1) Click "Menu" -> "Settings" in the Tool bar.

2) Click the “Account” tab and click "Add".

3) Enter a name.

4-2-1. How to Register the User ID

１

2

3

第4章 : Windows
Chapter 4: Windows

163



(C) NTT Communications All Rights Reserved

Go to Index

4) Enter the user ID written on the E-mail for guidance.
* If user doesn’t know User ID, contact the IT 

administrator in your company.

5) Click “OK”.

6) Select the user ID to be configured for default 
connection as needed, then set the default 
connection.

7) Click the “Log Setting” tab and change option setting if 
you need.

- Storing the connection log (ON/OFF)
… vApp connection log (Applog) can be acquired.
(Refer to <Supplemental Information> in 4-4-(2) for 

details.)

8) Click “OK”.

5

4

6

8

7
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1) Click "Menu" -> "Settings" in the Tool bar.

2) Click the “Account” tab and click the user ID to delete.

3) Click “Delete”.
* The user ID configured for default connection cannot 

be deleted. Continue deletion after setting other user 
ID for default connection.

4) Click “Delete”.

4-2-2. Modification of Settings of User ID (Deletion)

2

3

4

１
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4-2-3. Settings of Device Authentication

1) Click "Menu" -> "Settings" in the Tool bar.

2) Click “Option Settings" tab and put a check mark on the 
"Device Authentication Option".

3) The message "Are you sure you want to active the Device 
Authentication Option?" appears.
Click “OK”.

1

2

3

If you don't use function of device 
authentication, go to “4-3. VPN Connection/ 
Disconnection".

<Caution>
Turn off the Device Authentication option when you 
don't use this function. 

When you have configured more than one vClient-ID and 
function of Device Authentication is enabled.  Function 
will be applied to all configured vClient-ID.
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4

4) Click “OK”.

5) Click “Support" -> “Get Device ID" in the Tool bar.

6) Device-ID is displayed in the message.
*Device-ID：16 characters of letters and numbers.

7) If you would like to save the Device-ID by file, click “OK”.

5

6

7

[Device-ID]
File name: vapp_hardware_id.txt
Device-ID file location: desktop
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1) Click "Menu" -> "Connection" in the Tool bar.
Or,
click the “OFF” button.

* If the default setting is not configured, the Default 
Setting window appears.

Check "4-2-1 How to Register the User ID" and 
configure the default setting.

2) Enter the password.
* If password is unknown,

contact the system administrator.

3) Click “Connect”.

4) Terminal is connecting to the server. While the screen on 
the left is displayed, wait for a while.

5) When connection is established, the VPN Connect/ 
Disconnect button is switched to "ON".

6) "Connection Status" is switched to "Connected".

7) The "vApp Connected" balloon appears on the icon in 
the task tray.

4-3. VPN Connection/ Disconnection
4-3-1. Connection

Or,

１

5

6

7

１

３
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1) Click "Menu" -> "Disconnection" in the Tool bar.
Or,
click the “ON” button.

2) The terminal is being disconnected. While the screen on 
the left is displayed, wait for a while.

3) When connection is established, the “VPN Connect/ 
Disconnect” button is switched to "OFF".

4) "Connection Status" is switched to "Not Connected".

5) The "vApp Not Connected" balloon appears on the icon 
in the task tray.

*If an error occurs*

- Store the log file while referring to "P173 → Acquisition of communication status", and paste the  contents 
of text on the mail, then report the error to the System Administrator.

Then, contact our support desk through the Business Portal.

4-3-2. Disconnection

Or,

１

3

4

5

１
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1) Click the X mark at the upper light on the Home screen.
Or,
Click "Menu" -> "Exit" in the Tool bar.

2) The message confirming exit appears.
Click "OK".

4-3-3. Exit

Or,

１

１

２
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1) Click "Support" on the Tool bar.

* The following page describes each menu of the Support 
screen.

4-4. Other supports

１
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1) Visit Support Site
… Arcstar Universal One Virtual 

Jump to the Web site where 
support information, including
usage of vApp, is published. 

2) Acquisition of communication status
…Network information for 

device is acquired and stored 
if communication is stable or 
communication cannot be established.

3) Get device ID
...Refer to 4-2-3.

4) Communication test
... Check the communication

status of the network.
(ping/traceroute/nslookup)

5) Checking the update
... By selecting this menu, you can

check software update status.

6) Version information
... By selecting this menu, you can 

check the version of Arcstar 
Universal One Virtual vApp in use.

* Each menu of the Support screen is as follows.
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<Caution>
When updating the vApp, 
registered user IDs may be deleted.

Please write down user IDs before 
update. 
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1) Click “Support” -> “Visit Support Site" on the Tool bar.

2) The Customer Support screen appears.

(1) Visit Support Site

１
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1) Click "Support" -> “Save Network Statistics" on the Tool 
bar.

2) Specify an arbitrary folder and file name and save the 
file.

Original file name: yyyymmdd(date)_log.txt

(2) Acquisition of communication status

<Supplemental Information>
Acquisition of [AppLog]

Condition for Log acquisition: During communication
*Only if the Logging option is set to "ON“:

File name: sipd-date_log
↓

In the case of April 1, 2014, file name will be like "sipd-20140401_log”.

AppLog file location: 
*Location  for storing the log varies depending on OS version.
*Please change the file name as needed since each log will be saved as the same file name.

[In the case of 32 bit] 
The first : C drive > Program Files > NTT Communications > vApp
The second : C drive > Windows folder > System32 folder

[In the case of 64 bit]
The first : C drive > Program Files(x86) > NTT Communications > vApp
The second : C drive > Windows folder > System64 folder

１

２
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1) Click "Support" -> "Communication Test" on the Tool bar.

2) Click "▼".
The pull down menu appears.

3) Select and click the appropriate option from "ping", 
"traceroute" and "nslookup".

* Refer to the next page for the usage detail.

(4) Communication test

１

２

3

第4章 : Windows
Chapter 4: Windows

175



(C) NTT Communications All Rights Reserved

Go to Index

1) Enter the IP address/ host name.
(Example) www.ocn.jp

2) Click “Go".

3) The result start to appear on the window. 
Wait until log stops.

4) Click "Save Log File".

5) Specify any folder and file name and save the file.
Original file name: yyyymmdd_hhmmss_

NW_TestLog_windows.txt

5

1

3

24

●Operation procedures●

<Supplemental Information>
- yyyymmdd…Year, Month, Date
- hhmmss…Hour, Minute, Second
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1) Click "Support" -> "Check software update" on 
the Tool bar.

2) "Checking the Update of Software" or "Downloading the 
Update" appears on the screen for updating software is 
displayed.

Click "OK".

3) The latest version appears.
* If there is update, refer to "4-6 Others".

1

(5) Checking the update

2

<Note>
Message is written in bilingual Japanese and 
English.  Japanese characters in the message 
may be corrupt. However there’s no lack of 
function.
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<Caution>
When updating the vApp, registered user IDs may be 
deleted.

Please write down user IDs before update. 
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1) Click "Support" -> “About…" on the Tool bar.

2) The version of application appears.
Tap "OK".

1

2

(6) Version information
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1) Exit the application while the application is running.
* If there is an icon on the task tray, the application is 

running.
Exit the application when referring to "4-3-3 Exit".

2) Click "Control Panel" > "Uninstall Program".

* Operations vary depending on OS version.
Perform operations according to OS in use.

3) Double-click "vApp".

4) When the message “Are you sure to uninstall vApp?" 
appears, click "Yes".  

2

1

4

3

<If there is an icon on the task tray>

4-5. Uninstallation
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5) Uninstallation starts. While the screen on the left is 
displayed, wait for a while.

(6) Software is being uninstalled.
While the screen on the left is displayed, wait for a while. 

Wait for a while.

* Click "Control Panel" > "Add and Remove Programs" to 
confirm that vApp and Ubiquitous Client Virtual NIC 
do not appear.

* Click "Control Panel" > "System" > "System Properties" 
to select "Device Manager" in the "Hardware" tab.

Check that "VNiC Driver" does not appear in "Network 
Adapter" in device manager.
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2

1) When vApp runs, the screen for checking the update 
of software appears and "Check the update of 
Software" if update is necessary.

2) "Checking the Update of Software" or "Downloading 
the Update" appears on the screen for updating 
software is displayed.

Click "ON" on the screen for updating software is 
displayed.

3) “Receiving the Update” appears.

4) Click “OK”.4

1

4-6. Others
4-6-1. Update

<Note>
Message is written in bilingual Japanese and 
English.  Japanese characters in the message 
may be corrupt.  However there’s no lack of 
function.
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①App Storeへ接続して下さい。

②検索バーに「vApp」もしくは
「NTT communications」と入力し、検索して下さい。

③ 「vApp」アプリを選択し、インストールして下さい。

5－１．インストール

第5章 : Mac
Chapter 5: Mac

１

＜注意＞
アプリ名が類似している商品にご注意ください。
必ず、NTTコミュニケーションズ公式のものを
インストール願います。

＜補足＞
Webブラウザに以下のURLを直接入力した場合も、
Appストア上のvAppダウンロード画面へ遷移できます。
※バージョンやAppStoreに設定している国によって、

URLからダウンロードできない場合があります。
URL→https://itunes.apple.com/us/app/vapp/id839
416460?l=ja&ls=1&mt=8

この画像は表示できません。

２3
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ホーム画面の構成については下記の通りです。

VPN通信中のIPアドレスを確認する場合

ネットワーク環境設定画面に「IPアドレス」が表示されます。

※割当てられたIPアドレスは固定できません。

5－２．設定

第5章 : Mac
Chapter 5: Mac

 メニューバー

接続するユーザ名 VPNの接続/切断ボタン

メニューバー
・アカウントの追加や編集・削除、

オプションの設定を行う画面を表示します。

・サポートサイトへの案内や保守ツールを実行
できる画面を表示します。

 ステータスメニュー
ステータスメニュー
・設定に応じて、VPNの接続状況を表示できます。
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①vAppを起動して下さい。

②vAppのホーム画面が表示されます。

③メニューバーの「vApp」から「環境設定」を選択します。

④「+(プラス)」をクリックします。

１

5－２－１．ユーザID登録方法

第5章 : Mac
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３

4
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⑤任意の名前を入力して下さい。

⑥接続案内メール記載のユーザIDを入力して下さい。
※ユーザIDが分からない場合、

システム管理者へ確認してください。

⑦「OK」をクリックして下さい。

⑧「オプション設定」タブを選択して下さい。

⑨必要に応じてオプション設定を変更して下さい。
・接続ログを保存 (オン/オフ)

…AppLogを取得します。(AppLogの詳細は、5-4-(1)参
照)

・機体認証オプション (オン/オフ)
…機体認証機能の利用有無を選択します。

(機体認証の詳細は、5-2-3参照)

５
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6
7

9

この画像は表示できません。

8
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①メニューバーの「vApp」から「環境設定」を選択します。

②削除したいユーザIDを選択し、「－(マイナス)」を選択します。

2

5－２－２．ユーザID設定変更（削除）

第5章 : Mac
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①メニューバーの「vApp」から「環境設定」を選択します。

②「オプション設定」タブの「機体認証オプション」にチェック
を付けます。

③「OK」を選択します。

④「端末識別IDの取得表示」を選択します。

5－２－３．機体認証機能の設定

第5章 : Mac
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1

2

3

4

※機体認証機能を利用しない場合、
5－3. VPN接続／切断へ進みます。

＜注意＞
機体認証オプションを利用しない場合は、オプションを無
効にして下さい。

機体認証オプションが「オン」の場合、vAppに登録された
すべてのユーザIDに適用されます。
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⑤取得した端末識別ID(半角英数16字)は、お客様自身でシステム
管理者へ連絡して下さい。

⑥端末識別IDをファイルに保存する場合は、「保存」を
選択します。

5

第5章 : Mac
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＜注意＞
vAppのアンインストール等を行った場合、端末識別IDが
変わる場合がございます。
再インストール後は、必ず端末識別IDを再取得し、システ
ム管理者へご連絡ください。

6

【 端末識別ID 】
ファイル名：vApp_Hardware_Information.txt
保 存 場 所 ：ライブラリ > Containers > 

com.ntt.vapp.osx > Data > Documents > vApp_logs 
> CommunicationLog
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①接続したいユーザIDを選択し、「接続」をクリックしてくだ
さい。

②パスワードを入力し、接続をクリックします。
※パスワードが分からない場合、

システム管理者へ確認してください。

③「設定取得」をクリックします。
＊左図が表示されてから、5分以内にVPN接続操作を

行って下さい。

※初回利用の場合
…「設定取得」を選択して下さい。

構成プロファイルのインストールが開始されるため、
画面の指示に従いインストールを実行して下さい。

※既に構成プロファイルを設定取得した場合
…構成プロファイルの設定取得は不要です。

「ネットワーク環境設定を開く」を選択して下さい。

※事前共有鍵を更新した場合や、弊社設備にて
メンテナンス工事を行った場合には構成プロファイルを
再取得する必要があります。
その場合、必ず前回の構成プロファイルを削除した上で、
新たに構成プロファイルを取得してください。
詳細は、P.193の[補足]を参照してください。

＜注意＞
パスワードが違う場合、以下のエラーが表示されます。

２

5－３．VPN接続／切断
5－３－１．接続
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１

３
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＜注意＞
標準ブラウザを変更している場合は、標準ブラウザを「Safari」に変更してから
プロファイルのインストールをお願いいたします。
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④「続ける」をクリックします。

⑤「インストール」をクリックします。

⑥端末の「ユーザ名」と「パスワード」を入力し、「OK」を
クリックします。

⑦メニューバーの「ファイル」から
「”ネットワーク”環境設定を開く…」を選択します。

5

４

6

７

第5章 : Mac
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⑧インストールしたプロファイルを選択して下さい。

⑨「接続」をクリックします。
*「メニューバーにVPNの状況を表示」にチェックがついて

いる場合は、ステータスメニューに下記のマークが表示さ
れます。

⑩状況が「接続済み」、ネットワークの「●」が緑に変わりま
す。

９

８
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10

＜補足＞
マークのコンテキストメニューから、本操作の「接続」と
「接続解除」の操作が可能です。
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＜補足＞
Mac端末にインストールされたプロファイルを削除する方法は以下の通りです。

① Macの「アップルメニュー」をクリックし、「システム環境設定」を選択します。
② 「プロファイル」を選択します。
③ 削除したいプロファイルを選択し、「－」をクリックします。

1

2

3
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①メニューバーの「ファイル」から
「”ネットワーク”環境設定を開く…」を選択します。

②「接続解除」をクリックして下さい。
＊vAppの起動は必要ありません。

5－３－２．切断

第5章 : Mac
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２

194



(C) NTT Communications All Rights Reserved

Go to Index

①メニューバーの「vApp」から「vAppを終了」を選択します。

5－３－３．終了

第5章 : Mac
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１
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5－４．その他サポート

第5章 : Mac
Chapter 5: Mac

(1)vApp

(2)ファイル

(3)編集

(4)ウィンドウ

(5)ヘルプ

メニューバーの機能を紹介します。
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1) vAppについて
…ご利用中のArcstar Universal One Virtual vAppの

バージョンを確認することができます。

ソフトウェア使用許諾契約書 ボタン
…ソフトウェアの使用許諾契約書を表示します。

2) 環境設定...

アカウント タブ
…アカウントの登録、削除、編集を行います。

オプション設定 タブ
…オプションのオン/オフを設定します。

詳細は、次ページをご確認下さい。

3) vAppを終了
…vAppを終了します。

第5章 : Mac
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【 AppLog 】
取 得 条 件 ：通信時

＊接続ログを保存が「オン」の場合のみ

ファイル名 ：年月日_AppLog_MacOSX
↓

2014/4/1の場合
(例) 140401_AppLog_MacOSX

保 存 場 所 ：オプション設定タブの
「ログ保存フォルダを開く」を選択

(1)接続ログを保存
…AppLogを取得します。

(2)機体認証オプション
…機体認証機能の利用有無を選択します。

詳細は、5-2-3参照。

2) オプション設定タブ
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(5)ヘルプ
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1) サポートサイト
…Arcstar Universal One Virtual vAppのご利用方法な

どのサポート情報を掲載したサイトへジャンプしま
す。

2) 通信状態の取得
…通信が不安定や接続できない場合などにデバイスの

ネットワーク情報を取得・保存します。

3) 通信テスト
…ご利用のネットワークの通信状態を確認することが

できます。
（Ping/Traceroute/nslookup）
＊次ページで操作方法の流れを説明しています。

【 NWLog 】
取 得 条 件 ：通信状態の取得時

ファイル名 ：年月日_時分秒_NWLog_MacOSX
↓

2014/4/1の12:34 56秒の場合
(例) 140401_123456_NWLog_MacOSX

保 存 場 所 ：「ログ保存フォルダを開く」を選択
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①プルダウンから該当するものを選択して下さい。

②IPアドレス／ホスト名を入力して下さい。
（例）www.ocn.jp

③「実行」をクリックして下さい。

④ログが表示されます。しばらくお待ちください。

⑤「ログに保存」をクリックして下さい。

⑥「ログを保存しました。」と表示されます。
(保存したログの詳細は、下記のTest Logを参照ください)

●操作方法●

１

2

3

5

【 TestLog 】
取 得 条 件 ：通信テスト時

ファイル名 ：年月日_時分秒_TestLog_MacOSX
↓

2014/4/1の12:34 56秒の場合
(例) 140401_123456_ TestLog_MacOSX

保 存 場 所 ：「ログ保存フォルダを開く」を選択

4
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①Launchpadをクリックして下さい。

②vAppを2秒程長押しして下さい。

③アイコンが揺れ、左上に×印が表示されます。
×印をクリックして下さい。

１

5－５．アンインストール

第5章 : Mac
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２

3
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２3

5-1. Installation
1)Click the App Store icon on the Home screen.

2) Enter "vApp" or "NTT Communications" and then
perform searching.

3) Select "vApp" and then Install.

<Note>
Be careful with products having similar application name.
Be sure to install NTT Communications' official application.

<Supplemental Information>
The "Download vApp" screen on the App store opens even if the 
following URL is directly input on the Web browser.
* vApp may not be downloaded from the URL depending on 
versions and countries where AppStore is set.
URL→https://itunes.apple.com/us/app/vapp/id839416460?l=ja
&ls=1&mt=8
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Checking an IP address used for VPN connection.

The “IP Address” appears at the “Network Preferences…”.

* The IP address allocated by the server cannot be fixed.

第5章 : Mac
Chapter 5: Mac

 Menu bar

User name used for connection VPN Connect/ Disconnect button

Menu bar
- The screen for adding, editing and deleting an 

account appears. 
- The screen for setting options appears.
- The screen where guidance of the support site is 

available and maintenance tool can be executed 
appears.

- The screen for executing the maintenance tool 
appears.

 Status menu
Status menu
- Display the connection status of VPN, depending on 
setting.

5-2. Installation
Configuration of the Home screen is as follows.
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１
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３

4

1) Start vApp.

2) The Home screen of vApp appears.

3) Click [vApp] tab -> [Preferences…] .

4) Click the [+ (plus)] icon.

5-2-1. How to Register the User ID
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6
7

5) Enter a name.

6) Enter the user ID written on the E-mail for guidance.
* If user doesn’t know User ID, contact the IT 

administrator in your company.

7) Click [OK].

8) Click [Advanced] tab.

9) Change option setting if you need.
-Save Log(On/Off)

… vApp connection log (Applog) can be acquired.
(Refer to 5-4 (1).)

-Device Authentication Option(On/Off)
… This option(On) is needed when using the Device  
Authentication function. 

(Refer to 5-2-3.)

9

8
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2
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1

5-2-2. Modification of Settings of User ID (Deletion)

1) Click [vApp] tab -> [Preferences…].

2) Select the user ID which you want to delete, click the [-
(minus)] icon.
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1) Click [vApp] tab ->  [Preferences…].

2) Put a check mark on the "Device Authentication 
Option".

3) Click “OK”.

4)Click “Get Device-ID”.

第5章 : Mac
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1

2

3

4

5-2-3. Settings of Device Authentication

If you don't use function of device 
authentication, go to “5-3. VPN 
Connection/ Disconnection".

<Caution>
Turn off the Device Authentication option when you don't use 
this function. 

When you have configured more than one vClient-ID and 
function of Device Authentication is enabled.  Function will be 
applied to all configured vClient-ID.
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5) Device-ID is displayed in the message.
*Device-ID：16 characters of letters and numbers.

6) If you would like to save the Device-ID by file, click 
“Save”.

5
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6

[Device-ID]
File name: vApp_Hardware_Information.txt
Device-ID file location: library > Containers > 

com.ntt.vapp.osx > Data > Documents > vApp_logs > 
CommunicationLog

<Note>
When reinstalling vApp, the Device-ID will be changed.
In that case, you need to get Device-ID again and inform new 
Device-ID to System Administrator.
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1) Select the user ID which you want to use, and click “Start”.

2) Enter the password, then click “Connect”.
* If password is unknown,

contact the system administrator.

3) Click  “Get Profile”.
* Operation for establishing connection must be done 

within 5 minutes after the figure at left appears.

* When using the service for the first time
....Click “Get Profile”.

Installing the configuration profile starts;
therefore be sure to install  the configuration profile 
according to the instruction on the screen.

* When the configuration profile is already set and acquired:
...Acquisition of setting of the configuration profile is not 

required.
Click “Connect VPN".

２
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１

３

5-3. VPN Connection/ Disconnection
5-3-1. Connection

<Note>
If the password is different, the following error message 
appears.

209

<Note>
You must use "Safari" as Mac's default browser when installing the configuration profile.

*After our equipment maintenance or the pre-shared key is changed by the administrator, 
the configuration profile needs to be acquired again.
In that situation, please delete the configure profile which is already set first,
then re-install a new configure profile.
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5

４

6

７
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4) Click “Continue”.

5) Click “Install”.

6) Enter the device's “Username” and “Password”,
and then click “OK”.

7) Click [File] tab -> [Open Network Preferences…].
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8) Select the installed Profile.

9) Click “Connect”.
*If check box of "Show VPN status in menu bar" is 

checked, icon of below appears on status bar.

10) If VPN connection succeeded, status turns into 
"Connected", and a point's color of the Profile turns 
into green.

９

８
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<Supplemental Information>
The icon of contextual menu can operate as "Connect" and 
"Disconnect".
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２

5-3-2. Disconnection

1) Click [File] tab -> [Open Network Preferences…].

2) Click “Disconnect”.
* vApp  does not need to start up.
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１

5-3-3. Exit

1) Click [vApp] tab -> [Quit vApp].
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This chapter explains the function s  on menu bar.

5-4. Other supports

1) vApp

2) File

3) Edit

4)Window

5)Help
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1) About vApp
…By clicking this tab, you can  verify  the installed version of 

Arcstar Universal One Virtual vApp.

Software License Agreement button
…View Software License Agreement.

2) Preferences…

Accounts tab
…Configure account setting.

Advanced tab
…Set option(On/Off)

Refer to next page for details.

3) Quit vApp
…Quit vApp.

第5章 : Mac
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(1) vApp
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(1) Save Log option
… By selecting this option, vApp connection log 

(Applog) can be acquired.
(Detail of Applog are as follows.)

(2) Device Authentication Option
…This option(On) is needed when using The Device  

Authentication function. (Refer to 5-2-3.)

[AppLog]
Condition for Log acquisition: During communication

* Only if the Save Log option is set to "ON":

File name: date_AppLog_MacOSX
↓

In the case of April 1, 2014, file name will be like 
"140401_AppLog_MacOSX".

AppLog file location : Click [Advanced] tab -> 
[Open Log Folder].

第5章 : Mac
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2) Advanced tab
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1) Support site
…Arcstar Universal One Virtual Jump to the Web site 

where support information, including usage of vApp, is 
published.

2) Save Network Statistics
…Network information for device is acquired and stored 

if communication is stable or communication cannot be 
established.

3) Communication test
…Check the communication status of the network.  

(ping/traceroute/nslookup)
*Refer to the next page for the usage detail.
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(5) Help

[NWLog]
Condition for Log acquisition: Save Network Statistics

File name: date_time_NWLog_MacOSX
↓

In the case of the time is 12:34 56 seconds on April 1, 2014, 
file name will be like "140401_123456_NWLog_MacOSX”.

NWLog file location: Click [Open Log Folder] on this 
message.
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1) Click and select the appropriate option.

2) Enter the IP address/ host name.
(Example) www.ocn.jp

3) Click “Go”.

4) The result start to appear on the window. 
Wait until log stops.

5) Click "Save Log".
6) By clicking "Save Log", the message “Log has been 

saved." appears.
(Detail of saved log(TestLog) is as follows.)

第5章 : Mac
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１

2

3

5
4

●Operation procedures●

[TestLog ]
Condition for Log acquisition: Communication Test

File name: date_time_TestLog_MacOSX
↓

In the case of the time is 12:34 56 seconds on April 1, 2014, 
file name will be like "140401_123456_TestLog_MacOSX”.

TestLog file location: Click [Open Log Folder] on this message.
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２

3

5-5. Uninstallation

1) Click “Launchpad”.

2) Press and hold “vApp” icon on the screen of Launchpad 
for 2 seconds.

3) The "vApp" icon shakes and the X mark appears at the 
top left of icon. Click the X mark.
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vClientのパスワード変更の操作方法は以下のとおりです。

６－１．パスワード変更

NTTコミュニケーションズ株式会社 バーチャル様

Arcstar Universal One Virtualのクライアント登録が完了しました。
接続時の認証に必要な情報は以下の通りです。

ユーザID：UNOvirtual@N111111111.uno
パスワード：fasdi8534fadfa

アプリケーションは、以下のサイトからダウンロードしてください。
PC(Windows): http://support.ntt.com/vpn-virtual/download/search?dbFlg=1
Mac(OS X): https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

接続時の認証パスワードを変更する場合は、以下の利用者向けポータルにアクセスして実施してください。
https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx

ログインID：上記ユーザーIDの@左側のIDを入力してください。
パスワード：上記パスワードを入力してください。

メール件名 ： [Arcstar Universal One Virtual] Notice of information about client connection

・クライアント接続情報のメール内容

Webブラウザに、接続案内メールに記載されている
「利用者向けポータル」のURLを入力し、

利用者向けポータルを表示します。

第6章 : パスワード変更
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メール送信の都度、メールに記載された<認証パスワードを変更するサイトのURL>が、更新されま
す。複数回メール受信された場合は、最後に受信したメールに記載されたURLへアクセスしてくだ
さい。

古い<認証パスワードを変更するサイトのURL>へアクセスした場合、以下の画面が表示されます。

第6章 : パスワード変更
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NTTコミュニケーションズ株式会社 バーチャル様

Arcstar Universal One Virtualのクライアント登録が完了しました。
接続時の認証に必要な情報は以下の通りです。

ユーザID：UNOvirtual@N111111111.uno
パスワード：fasdi8534fadfa

アプリケーションは、以下のサイトからダウンロードしてください。
PC(Windows): http://support.ntt.com/vpn-virtual/download/search?dbFlg=1
Mac(OS X): https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

接続時の認証パスワードを変更する場合は、以下の利用者向けポータルにアクセスして実施してください。
https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx

ログインID：上記ユーザーIDの@左側のIDを入力してください。
パスワード：上記パスワードを入力してください。

メール件名 ： [Arcstar Universal One Virtual] Notice of information about client connection

・クライアント接続情報のメール内容

ログイン画面に、IDとPWを入力し、
ログインボタンをクリックします。

・ID…接続案内メール「ユーザID」の「＠」より前を入力してください。
例).UNOvirtual

・PW…接続案内メール「パスワード」を入力してください。
例). Fasdi8534fadfa

※入力したパスワードは「・」で表示されます。

第6章 : パスワード変更
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パスワード変更ボタンをクリックします。

現在のパスワード、新しいパスワードを入力し
変更ボタンをクリックします。
※入力したパスワードはすべて「・」で表示されます。

・現在のパスワード…接続案内メール「パスワード」を入力してください。

・新しいパスワード…任意のパスワードを入力してください。

・確認…新しいパスワードに入力したパスワードを入力してください。

パスワードは、半角英字の大文字・小文字、数字を全て含んだ8字以上31字以内で設定して
ください。すべてのパスワードで条件を満たしていない場合、変更ボタンをクリックしても、
反映されません。

注意事項

第6章 : パスワード変更
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しばらくすると、
パスワード変更の成功メッセージが表示されます。

注意事項

一度パスワード変更をされた場合、以降の「クライアント接続情報のメール」には
パスワードは記載されません。

パスワード変更後にパスワードを忘れた場合、システム管理者にお問い合わせください。

NTTコミュニケーションズ株式会社 バーチャル様

Arcstar Universal One Virtualのクライアント登録が完了しました。
接続時の認証に必要な情報は以下の通りです。

ユーザID：UNOvirtual@N111111111.uno
パスワード：(変更されたパスワード)

アプリケーションは、以下のサイトからダウンロードしてください。
PC(Windows): http://support.ntt.com/vpn-virtual/download/search?dbFlg=1
Mac(OS X): https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

接続時の認証パスワードを変更する場合は、以下の利用者向けポータルにアクセスして実施してください。
https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx

ログインID：上記ユーザーIDの@左側のIDを入力してください。
パスワード：ご自身で変更されたパスワードを入力してください。

メール件名 ： [Arcstar Universal One Virtual] Notice of information about client connection

第6章 : パスワード変更
Chapter 6: Changing the Password

225

http://support.ntt.com/vpn-virtual/download/search?dbFlg=1
https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
https://play.google.com/store/apps/details?id=com.ntt.vapp
https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8


(C) NTT Communications All Rights Reserved

Go to Index

Operation for changing the password of vClient is as follows.

6-1. Changing the password

Dear Virtual in NTT Communications Corporation

Registration of client of Arcstar Universal One Virtual is completed.
Information required for authentication upon connection is as follows.

User ID: UNOvirtual@W111111111.uno
Password: fasdi8534fadfa

Download application from the following web site.
PC(Windows): http://support.ntt.com/en/vpn-virtual/download/detail/pide21000000az
Mac(OS X): https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

When changing the authentication password used upon connection, change the password by accessing to the portal for 
users.

https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx
Login ID: Enter the ID located at the left of @ in the above user ID.
Password: Enter the above password.

Subject of Email: [Arcstar Universal One Virtual] Notice of information about client connection

- Contents of mail indicating client connection information

Enter the URL of the "portal for users" described in the E-mail for guidance 
of connection on Web browser to display the portal for users.
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<URL for the Web site for changing the authentication password> is updated. If the Emails 
are received for multiple times, access to the URL described on the last received Email.

When accessing to the old <URL of the Web site for changing the authentication 
password>, the following screen appears.

Message of “Mail indicating client connection information” and “Error display of the portal 
for users” are written in bilingual Japanese and English.  Japanese characters in the 
message may be corrupt.  However there’s no lack of function.
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Dear Virtual in NTT Communications Corporation

Registration of client of Arcstar Universal One Virtual is completed.
Information required for authentication upon connection is as follows.

User ID: UNOvirtual@W111111111.uno
Password: fasdi8534fadfa

Download application from the following web site.
PC(Windows): http://support.ntt.com/en/vpn-virtual/download/detail/pide21000000az
Mac(OS X): https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

When changing the authentication password used upon connection, change the password by accessing to the portal for 
users.

https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx
Login ID: Enter the ID located at the left of @ in the above user ID.
Password: Enter the above password.

Subject of Email: [Arcstar Universal One Virtual] Notice of information about client connection

- Contents of the mail indicating client connection information

Enter ID and PW on the Login screen and click the Login button.

- ID…Enter the portion in front of "@" of the User ID in the mail for guidance 
of connection.

Example).UNOvirtual

- PW…Enter the portion in front of "@" of the User ID in the mail for guidance 
of connection.

Example). Fasdi8534fadfa
* The input password is displayed with ".".

第6章 : パスワード変更
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Set the password using characters at least 8 characters in length, and no more than 31 
characters, including uppercase letters, lowercase letters and numbers.
If all passwords do not meet conditions, password is not reflected even if the "Change" 

button is clicked.

Important Notes

Click the “Password Change” button.

Enter the old password and new password, then click the Change  button.
* The input password is displayed with ".".

- Current password…Enter password in the mail for guidance of connection.

- New password: Enter any password.

- Confirm: Enter the password entered in New password.
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Important Notes

If the password is changed, password is not described in the following "E-mail indicating 
client connection information".

If you forget the password after changing the password, contact the system administrator.

Wait for a while until the message indication 
completion of change of password appears.

Dear Virtual in NTT Communications Corporation

Registration of client of Arcstar Universal One Virtual is completed.
Information required for authentication upon connection is as follows.

User ID: UNOvirtual@W111111111.uno
Password: fasdi8534fadfa

Download application from the following web site.
PC(Windows): http://support.ntt.com/en/vpn-virtual/download/detail/pide21000000az
Mac(OS X):https://itunes.apple.com/us/app/vapp/id1046702335?l=ja&ls=1&mt=12
Android: https://play.google.com/store/apps/details?id=com.ntt.vapp
iOS: https://itunes.apple.com/us/app/vapp/id839416460?l=ja&ls=1&mt=8

When changing the authentication password used upon connection, change the password by accessing to the portal for 
users.

https://usd.portal.ntt.net/?key=xxxxxxxxxxxxxxxx
Login ID: Enter the ID located at the left of @ in the above user ID.
Password: Enter the above password.

Subject of Email: [Arcstar Universal One Virtual] Notice of information about client connection
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注意事項

エラーが表示された場合、以下の対応方法をご確認ください。

エラーコード
原因 対応方法

1 名前を入力してください。 <名前>を未入力で登録し
ようとしたため。

<名前>を入力してください。

2 ユーザIDを入力してくだ
さい。

<ユーザID>を未入力で登
録しようとしたため。

<ユーザID>を入力してください。

3 既に使われている名前で
す。

既に登録された<名前>で
登録しようとしたため。

別の<名前>を入力してください。

4 既に使われているIDです。 既に登録された<ユーザ
ID>で登録しようとした
ため。

別の<ユーザID>をシステム管理者
から発行されている場合は、別の<
ユーザID>を入力してください。

5

522 522 5020

ログイン時の<パスワー
ド>に相違があるため。
または、アプリとポータ
ルで機体認証の設定が一
致していないため。

正しい<パスワード>を入力してく
ださい。
また、アプリとポータルで機体認
証の設定が一致しているかをシス
テム管理者へお問い合せください。

６

522 526 5020

<ユーザID>が使用中
(VPN接続中)のため。

以下のいずれかを行ってください。
・別の<ユーザID>をシステム

管理者から発行されている
場合は、別の<ユーザID>で
VPN接続を行ってください。

・VPN接続中の<ユーザID>を
一度切断してから操作して
ください。

vApp起動時のエラー

Windows iOS/Mac Android

第7章 : エラーコード
Chapter 7: Error code

7－１．エラーコード

弊社お客様サポートページに「よくあるご質問」を掲載しております。
問題解決の一助としてご参考いただけますと幸いです。

NTTコミュニケーションズ お客様サポート(Arcstar Universal One Virtual) トップ
<http://support.ntt.com/vpn-virtual>

お客様サポート(Arcstar Universal One Virtual) よくあるご質問
<http://support.ntt.com/vpn-virtual/faq/search>
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エラーコード
原因 対応方法

７
500 599 2564

使用可能なネットワーク
がないため。

使用可能なネットワークを準備し、
VPN接続を行ってください。

8
500 599 2560 ネットワークの通信状況

が不安定なため。
ネットワークの通信状態が良い環
境で、VPN接続を行ってください。

9

632 - 13

VPN切断後、すぐに同じ
<ユーザID>で再度VPN接
続を行ったため。

認証サーバに<ユーザID>がVPN接
続中の状態である事が保持されて
いる場合があります。
5分以上時間をおいて、再度VPN接
続を行ってください。

vApp起動時のエラー

ユーザID設定時のエラー

エラーコード
原因 対応方法

10
527 527 5020

登録した<ユーザID>が相
違しているため

正しい<ユーザID>を入力して
ください。

11
527 527 5020

システム管理者による
<ID設定>が行われていな
いため。

システム管理者へ<ID>の設定
を依頼してください。

12
522 525 5020

発行された<ユーザID>に
vClientグループ設定が行
われていないため。

システム管理者へvClientグルー
プ設定についてお問い合わせく
ださい。

13
522 525 5020

ユーザIDの所属する
vClientグループにvCore
が設定されていないため。

vClientグループにvCoreを設定
してください。

14
633 - 1000

vCore設定変更に伴うネッ
トワーク切断のため。

vCoreの設定が完了してから、
VPN接続を行って下さい。

第7章 : エラーコード
Chapter 7: Error code
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ユーザID設定時のエラー

エラーコード
原因 対応方法

15
633 - 1000

VNS(サーバ)から切断さ
れたため。

vCoreが停止状態の場合、シス
テム管理者へvCoreの起動を依
頼して下さい。

16
522 525 5020

vCoreが起動していないた
め。

システム管理者へvCoreの起動
を依頼して下さい。

17
522 526 5020

システム管理者によって、
ユーザIDのステータスが
「停止中」に設定されて
いるため。

システム管理者へユーザIDのス
テータス「停止中」の設定解除
依頼をしてください。

18
- ※1 -

アクセス制御のunderlay
アドレス制限のため接続
できないため。

システム管理者にてアドレス制
御の設定を確認してください。

※１…PPPサーバによって、接続が解除されました。もう一度接続してください。

*See the next page in English.

エラーコード
原因 対応方法

19

330

アプリの異常終了により、端末
上でアプリを終了と認識できて
いないため

アプリを再起動してください。
それでも回復しない場合は、端
末を再起動してください。
また、こちら(P.137)の対応方
法もあわせてご確認ください。

Windows

エラーコード
原因 対応方法

20 599 使用している端末で、既にVPN
接続中のため。

接続中のVPNを切断してから、
操作を行ってください。

iOS / Mac

第7章 : エラーコード
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Important Notes

Refer to the following response method when an error is displayed.

Error code
Cause Response method

1 Enter the name. Registration is attempted 
while <Name> is not 
entered.

Enter the <Name>.

2 Enter the user ID. Registration is attempted 
while <User ID> is not 
entered.

Enter the <User ID>.

3 This name is already used. Registration is attempted 
with the already registered 
<Name>.

Enter the other <Name>.

4 This ID is already used. Registration is attempted 
with the already registered 
<User ID>.

If other <User ID> is issued by the 
system administrator, enter other
<User ID>.

5

522 522 5020

<Password> entered upon 
login is different.
Or, setting of the vApp 
Device-ID does not match 
with the Portal's setting of 
terminal authentication ID.

Enter the correct <Password>.
Otherwise, ask the system 
administrator whether the setting of 
the vApp Device-ID matches setting 
of terminal authentication ID in the 
Portal.

6

522 526 5020

<User ID> is in use (VPN
connection is established).

Carry out one of the following 
actions.
- Please used other <User ID>  
issued by the system administrator.
- Please disconnect established 
VPN connection and reconnect with 
same <User ID>.

Error upon activation of vApp

Windows iOS/Mac Android

7-1. Error code

NTT Com would like customer to refer to FAQ on NTT Com’s customer support website in 
being trouble.

NTT Com’s customer support website (top page of Arcstar Universal One Virtual)
<http://support.ntt.com/en>

FAQ (Arcstar Universal One Virtual)
<http://support.ntt.com/en/vpn-virtual/faq/search>

第7章 : エラーコード
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Error code
Cause Response method

7 500 599 2564 There is no available 
network.

Prepare available network and 
establish VPN connection.

8
500 599 2560 Communication status of 

network is instable.

Establish the VPN connection in the 
environment where the network's 
communication status is good.

9

632 - 13

After disconnecting VPN,
VPN connection is 
immediately established 
with the same <UserID>
again.

The status of <UserID> may be 
retained as "connecting to VPN" in 
the authentication server.
Wait for 5 minutes or longer and the 
establish VPN connection.

Error upon activation of vApp

Error that occurs when setting the userID

Error code
Cause Response method

10
527 527 5020

The registered <User ID> is 
wrong.

Enter the correct <User ID>.

11
527 527 5020

<ID settings> are not 
configured by the system 
administrator.

Request the system administrator to 
set <ID>.

12
522 525 5020

vClient group is not set for the 
issued <User ID>.

Ask the system administrator about 
settings of vClient group.

13
522 525 5020

The system administrator does 
not combine vCore and  user 
ID.

Connect vClient group and vCore.

14
633 - 1000

Network is disconnected 
according to changes of vCore 
setting.

After setting of vCore is completed, 
establish VPN connection.

第7章 : エラーコード
Chapter 7: Error code
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Error that occurs when setting the userID

Error code
Cause Response method

15
633 - 1000

Disconnected from VNS 
(server).

System administrator reboot vCore in 
case of stopping vCore.

16
522 525 5020

vCore is not activated. System administrator reboot vCore.

17
522 526 5020

The system administrator set 
the status of user ID as 
“Stopping”.

System administrator release the 
status of user “Stopping”.

18

- *1 -

Connection cannot be 
established due to underlay 
address restriction for access 
control.

System administrator confirm to 
control IP address.

*１…Connection is released by the PPP server. Establish the connection again.

Error code
Cause Response method

19

330

The terminal does not recognize 
that the application exits due to 
abnormal termination of 
application.

Restart the application. Restart the 
terminal if the terminal does not 
recover even after the application 
is restarted.
And also refer to HERE (P.160).

Windows

Error code
Cause Response method

20
599

VPN connection is already 
established with the terminal in 
use.

Operations need to be done 
after disconnecting VPN.

iOS / Mac

第7章 : エラーコード
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